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What’s New in this Guide



Minor edits and cover page update for current release.
Update the support status in Appendix H: The Supported and Unsupported Methods to Copy or
Move Sites of Different SharePoint Experience Versions
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About Content Manager
DocAve Content Manager for SharePoint 2010 and SharePoint 2013 provides administrators with the
ability to comprehensively move, copy, and restructure SharePoint sites, Apps for SharePoint, content,
and topology within or across SharePoint on-premises and online environments. Through a centralized,
highly intuitive management console, featuring familiar ribbon-based controls and wizard-based, stepby-step guidance, administrators can seamlessly manage and restructure SharePoint content with
minimal interruption to business processes in order to quickly respond to evolving information
governance requirements.
*Note: AvePoint is not responsible for any circumvention of a SharePoint app’s license that may occur
from moving an app from one site collection to another or one farm to another. It is the customer’s
responsibility to ensure that all licenses for the app have been purchased and deployed properly.
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Complementary Products
Many products and product suites on the DocAve 6 platform work in conjunction with one another. The
following products are recommended for use with Content Manager:


DocAve Connector for collaborating upon network file shares and cloud storage
resources directly through SharePoint without migration. Connected content appears as
normal SharePoint content, and can be leveraged exactly as if it were residing within a
SharePoint document library.



DocAve Replicator for SharePoint for copying SharePoint content within the same
SharePoint farm or from one SharePoint farm to another.



DocAve Report Center for SharePoint to examine pain points in the SharePoint
infrastructure and report on SharePoint user behavior and changes.



DocAve Data Protection for setting backup and recovery points prior to adjusting
SharePoint governance policies in this product.
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Submitting Documentation Feedback to AvePoint
AvePoint encourages customers to provide feedback regarding our product documentation. You can
Submit Your Feedback on our website.
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Before You Begin
Refer to the sections to review the system requirements for DocAve Content Manager.

AvePoint’s Testing Policy and Environment Support
Supported Hardware
AvePoint is committed to maintaining a hardware agnostic platform to ensure that DocAve operates on
common Windows file sharing and virtualization platforms. To ensure that DocAve is hardware agnostic,
AvePoint tests hardware that is intended to support SharePoint and DocAve infrastructure, storage
targets, and hardware-based backup and recovery solutions, as supported by AvePoint’s partnerships.
AvePoint directly integrates with the following platforms: any Net Share, IBM Storwize Family, FTP,
Amazon S3, AT&T Synaptic, Dropbox, Box, Caringo Storage, Del DX Storage, EMC Centra, HDS Hitachi
Content Platform, Rackspace Cloud Files, TSM, Network File System, and Windows Azure Storage.
All other hardware platforms that support UNC addressable storage devices are supported.
*Note: Most of the hardware partnerships referenced in this guide are intended to make use of
advanced functionality (such as snapshot mirroring, BLOB snapshots, indexing, long-term storage,
WORM storage, etc.), and are not indications that any changes to the product are required for basic
support. In most cases, hardware can be supported with no change to the product.

Supported Backup and Recovery
DocAve supports BLOB backup storage according to the list of hardware platforms above. BLOB
snapshot functionally, however, is currently only supported on OEM versions and NetApp hardware.
DocAve supports SQL content and Application database backups via the SharePoint Volume Shadow
Copy Service (VSS) on all Windows and SQL server platforms listed above. DocAve also supports
snapshot-based SharePoint VSS on all hardware listed above where the hardware partner has certified
support with Microsoft.
DocAve supports application and configuration server backups for all the supported software
environments listed above. DocAve 6 SP5 supports VM backup via Hyper-V/VMWare for the following
operating systems: Windows Server 2008 R2, Windows Server 2012, Windows Server 2012 R2, and
Microsoft Hyper–V Server 2012 R2.

DocAve 6: Content Manager

9

Configuration
In order to use Content Manager, the DocAve 6 platform must be installed and configured properly on
your farm.
For instructions on installing the DocAve Platform, DocAve Manager, and DocAve Agents, refer to the
DocAve 6 Installation Guide.

Required Permissions
To install and use Content Manager properly, ensure that the following permissions are met.

Content Manager for SharePoint On-Premises
Before using Content Manager for SharePoint on-premises, ensure that the Agent account has the
following permissions:
1. Local System Permissions: These permissions are automatically configured by DocAve during
installation. Refer to Local System Permissions for a list of the permissions automatically
configured upon installation. If there are no strict limitations on the permissions, you can simply
add the DocAve Agent account to the local Administrators group to apply all of the required
permissions.
2. SharePoint Permissions: These permissions must be manually configured prior to using
DocAve 6 Content Manager; they are not automatically configured.


User is a member of the Farm Administrators group. Since administrator works across
farms and on all SharePoint settings and configurations, this account is needed in order
to provide the most complete quality of service.



Full Control to all zones of all Web applications via User Policy for Web Applications



Full Control to the User Profile Service
*Note: This permission is required to copy or move My Sites to a destination. However,
to ensure a successful copy or move action on My Site, grant the User Profile Service
that is associated with the destination Web application Full Control and Administrator
with Full Control permissions to the Application pool account of the destination Web
application.



User Profile Service Application permission:
o

o
10

For SharePoint 2010


Use Personal Features



Create Personal Site



Use Social Features

For SharePoint 2013
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Create Personal Site (required for personal storage, newsfeed, and
followed content)



Follow People and Edit Profile



Use Tags and Notes



Managed Metadata Service: Term Store Administrator



Search Service: Full Control



Business Data Connectivity Service: Full Control

*Note: To deploy apps, the Agent account cannot be a system account.
3. SQL Permissions: These permissions must be manually configured prior to using DocAve 6
Content Manager; they are not automatically configured.


db_owner database role in all of the databases related to SharePoint, including
Content, Configuration, Central Administration content, User Profile Service, and App
Management databases.



db_owner database role in the Nintex Workflow databases, including configuration and
content databases.

If a Web application enables the forms-based authentication and uses the database as the
method of forms-based authentication, ensure at least one condition:


The Agent account has the db_owner database role in the FBA database.



Select a user in the connectionString node in this Web application’s web.config profile
that has the access to the FBA database.

Local System Permissions
Some local system permissions are automatically configured during DocAve 6 installation. The user will
be set up as a member of the following local groups:


IIS WPG (for IIS 6.0) or IIS IUSRS (for IIS 7.0)



Performance Monitor Users



DocAve Users (this group is created by DocAve automatically with the following
permissions):
o

Full Control to the Registry of
HKEY_LOCAL_MACHINE\SOFTWARE\AvePoint\DocAve6

o

Full Control to the Registry of
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\EventLog

o

Full Control to the Communication Certificate

o

Permission of Log on as a batch job (navigate to: Control Panel > Administrative
Tools > Local Security Policy > Security Settings > Local Policies > User Rights
Assignment)
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o

Full Control to the DocAve Agent installation directory

Content Manager for SharePoint Online
Before using Content Manager for SharePoint Online, ensure that you meet the following prerequisites:


You have purchased the corresponding license for Content Manager for SharePoint
Online.



You have created the SharePoint Sites Group in Control Panel and added one or more
SharePoint on-premises or SharePoint Online site collections to the group. For more
information, refer to the Control Panel Reference Guide.

Registered SharePoint On-Premises Site Collection
The following permissions are required for Content Manager to manage registered SharePoint onpremises site collections.
Required Permissions for Agent Account
The permission requirements for the Agent account used for Content Manager for SharePoint Online are
as follows:


Local System Permissions: To install and use Content Manager properly, ensure that the
Agent account has the proper Local System Permissions. DocAve automatically
configures some permissions during installation. Refer to Local System Permissions for
more details. .
If there are no strict limitations on the permissions, you can simply add the DocAve
Agent Account to the local Administrators group to apply all of the required
permissions.

Required Permissions for the User Used to Register the SharePoint On-Premises Site Collection
The user that is used to register SharePoint on-premises site collections in Control Panel > Registered
SharePoint Sites > Manual Input Mode must have the following permissions to each site collection:


User is a member of the Site Collection Administrator group.



User Profile Service Application:
o

Follow People and Edit Profile

o

Use Tags and Notes



Managed Metadata Service: Term Store Administrator



The Read permission to the Apps for SharePoint library in the App Catalog Site
Collection

The user that is used to register SharePoint on-premises site collections in Control Panel > Registered
SharePoint Sites > Scan Mode must have the following permissions:
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Full Control permission to all zones of all Web applications via User Policy for Web
Applications.



Member has a Database Role of db_owner for all of the databases related to
SharePoint, including Content Databases, SharePoint Configuration Database, and
Central Admin Database.

Registered SharePoint Online Site Collections
The following permissions are required for Content Manager to manage registered SharePoint Online
site collections.
Required Permissions for Agent Account
The permission requirements for the Agent account used for Content Manager for SharePoint Online are
as follows:


Local System Permissions: To install and use Content Manager properly, ensure that the
Agent account has the proper Local System Permissions. DocAve automatically
configures some permissions during installation. Refer to Local System Permissions for
more details. .
If there are no strict limitations on the permissions, you can simply add the DocAve
Agent Account to the local Administrators group to apply all of the required
permissions.

Required Permissions for the User Used to Register SharePoint Online Site Collections
The user that is used to register SharePoint Online site collections in Control Panel > Registered
SharePoint Sites > Manual Input Mode must have the following permissions to each site collection:
*Note: The user must have the following permissions to each site collection added to the SharePoint
Sites Group.


User is a member of the Site Collection Administrator group.



User Profile Service:
o

Follow People and Edit Profile

o

Use Tags and Notes



Managed Metadata Service: Term Store Administrator



The Read permission to the Apps for SharePoint library in the App Catalog Site
Collection

*Note: If the site collections are registered in Scan Mode, make sure the user has the SharePoint
administrator role in Office 365.
*Note: To copy/move SharePoint Online objects, the Add and Customize Pages permission is required.
Users with the role of SharePoint administrator or Site Collection Administrator have the Add and
Customize Pages permission, but you must select Allow users to run custom script on personal sites
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and Allow users to run custom script on self-service created sites in SharePoint admin center >
settings > Custom Script to enable the permission to these users. Note that the changes will take effect
24 hours after being set.

Health Analyzer
AvePoint recommends using Health Analyzer to check the prerequisites you need to correctly use
DocAve Content Manager.
*Note: Only the users in the DocAve Administrators group can use Health Analyzer.
*Note: For the rule Agent Account Cannot be SharePoint System Account, you can ignore the result of
this rule if you are not going to deploy apps on the specific Web applications.
For more information about Health Analyzer, refer to the DocAve 6 Installation Guide.
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Getting Started
Refer to the sections below for important information on getting started with Content Manager.
*Note: When logging into DocAve Manager and operating the Content Manager module using the users
in the System groups, the users can only operate the:


Farms to which it has permission.



Functions to which it has permission.



DocAve objects (such as, plans, jobs, registered SharePoint sites, and so on) to which it
has permission.

Administrators or the users in the System groups can grant different permission levels to different
farms. For more information on permission control of users in the System group, refer to the Control
Panel Reference Guide.

Launching Content Manager
To launch Content Manager and access its functionality, complete the following steps:
1. Click the DocAve tab to display all product suites for DocAve 6.
2. Click Administration to access the Administration modules.
3. Click Content Manager to launch this module.

Figure 1: DocAve module launch window.
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Navigating DocAve
DocAve mimics the look and feel of many Windows products, making for an intuitive and familiar
working environment. While there are many windows, pop-up displays, and messages within DocAve
products, they share similar features and are navigated in the same ways.
Below is a sample window in DocAve. It features a familiar, dynamic ribbon, and a searchable, content
list view.

Figure 2: Navigating DocAve.

1. Ribbon Tabs— Allows users to navigate to the DocAve Welcome page and within the active
module.
2. Ribbon Panes – Allows users to access the functionality of the active DocAve module.
3. Manage columns ( ) – Allows users to manage which columns are displayed in the list. Click the
manage columns ( ) button, and then select the checkbox next to the column name in the
drop-down list.
4. Filter the column ( ) – Allows users to filter the information in the List View. Click the filter the
column ( ) button next to the column and then select the checkbox next to the column name.
5. Hide the column ( ) – Allows users to hide the selected column.
6. Search – Allows users to search the List View pane for a keyword or phrase. You can select
Search all pages or Search current page to define the search scope.
*Note: The search function is not case sensitive.
7. Management Pane – Displays the actionable content of the DocAve module.
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Content Manager Interface
The Content Manager user interface is made up of the following four main areas:
1. Tabs – Navigate between the different tabs of Content Manager.
2. Ribbon – Toolbar where you can perform actions, configure settings, and access Job Monitor for
Content Manager jobs.
3. Source pane – Access the SharePoint objects at different levels of your farms with content that
you want to copy or move.
4. Destination pane – Access the SharePoint objects at different levels of your farms with content
that you want to copy or move.

Figure 3: Content Manager Interface.
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Basic Content Management Functions
While Content Manager allows you to create plans so that you can repeatedly copy and/or move jobs
without having to reconfigure the settings each time, you can also perform these simple tasks without
having to create an entire plan.


Copy – When Content Manager runs a copy job, SharePoint content, configurations, and
securities are copied from the source nodes to the destination node based on the
settings you configured in Default Copy Settings.



Move – When Content Manager runs a move job, SharePoint content, configurations,
and securities are copied from the source nodes to the destination node based on the
settings you configured in Default Move Settings. The source node content and
securities are then deleted. The deletion of the source content and securities can be
configured to occur automatically after the Move job is complete, or you may choose to
manually delete the content.
*Note: Only the items that are successfully migrated to the destination within lists are
deleted in the source node content. The securities of the container level objects (e.g.
Web application, site collection, site, list, and folder) are not deleted.



Create Container – Content Manager allows you to create containers within SharePoint
without having to leave the DocAve interface. The Create Container feature is useful in
cases where you want to copy or move content from the source nodes to a new
destination node without having to pre-create the destination node within SharePoint.

*Note: If you select the Include New checkbox in the Source pane, content created after the plan is
saved will be included when the plan is executed.
*Note: If you select My Site in the Source pane, use the SP2013CMCustomURLMapping.xml file to map
the URL of the content that the user follows in the personal site to the designated address of the linked
content. Complete the following steps to modify the file for the URL mappings:
1. Go to the server where your destination DocAve Agent resides. Navigate to
…\AvePoint\DocAve6\Agent\data\SP2013\ContentManager directory.
2. Open the SP2013CMCustomURLMapping.xml file with Notepad, and the following nodes will
appear:
<CustomUrlMappings>
<UrlMapping Source="" Destination=""/>
</CustomUrlMapping>
3. Enter the original URL of the content that the user follows as the value of the Source attribute
and the designated URL you are about to map as the value of the Destination attribute.
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*Note: If desired, you can add multiple <Url Source="SourceUrl"
Destination="DestinationUrl"/> nodes to map more URLs of the linked content to the
designated ones.
4. Save your configurations and close the file.
After the Content Manager job is finished, the URLs of the content that the user follows are
successfully mapped to the designated destination addresses of the linked content.
*Note: If the following conditions are met, automatic mappings will be performed on objects
within a site, according to relative URLs.
a. A source site URL is mapped to a destination site URL in the
SP2013CMCustomURLMapping.xml file.
b. The URLs of objects within the source site are not manually mapped to designated URLs
in the SP2013CMCustomURLMapping.xml file.
For example, if the site URL http://SourceWebApp/SourceUrlMappingSite is manually mapped
to the site URL http://DestWebApp/DestUrlMappingSite. The document URL
http://SourceWebApp/SourceUrlMappingSite/SourceLib/document.doc will be automatically
mapped to the document URL
http://DestWebApp/DestUrlMappingSite/DestLib/document.doc.
*Note: When selecting My Site in the Source pane, make sure that the application pool account of the
destination Web application meets the following conditions:


Is the Administrator of the User Profile Service currently in use.



Has Full Control permission to the User Profile Service currently in use.

*Note: You can control whether to update the URL that is linked to an object and whether to update the
URL of an object after the object is moved to a new destination within the same site collection by
completing the following steps:
1. Log into each DocAve Agent server.
2. Go to the ...\AvePoint\DocAve6\Agent\data\SP2010\ContentManager directory.
3. Open the SP2010CMConfiguration.xml file using Notepad.
4. There are two nodes to control the update of URL:


Locate the <ReplaceBackwardLinksInSameSite value="false"/> node. If modifying its
value to true, the URL that is linked to an object will be updated to the new one after
the source object is moved to a new location within the same site collection and the
source content is deleted.



Locate the <ReplaceForwardLinksInSameSite value="true"/> node. If keeping its value
as true, the URL that is added to an object will be updated when the object is copied or
moved to a new location within the same site collection.
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5. Save the changes and close the file.
*Note: You can download the job details and related logs in Job Monitor. For more information, refer to
Job Monitor Reference Guide.

Copying Content
The following two sections explain how to configure Default Copy Settings and how to perform a simple
copy of content. Use the Default Copy Settings to customize a template for your copy settings. These
settings will be applied to any new copy jobs you create. You will be able to edit these settings. To
configure the default copy settings, complete the following steps:
1. In the Home tab of the Content Manager interface, click Copy on the ribbon.
2. Select Default Copy Settings from the drop-down menu. The Default Copy Settings tab appears.
To edit the configured default copy settings before running a copy job, complete the following steps:
1. In the Home tab of the Content Manager interface, click Copy on the ribbon.
2. Select Copy from the drop-down menu. The Copy tab appears.
3. Click Edit on the ribbon. The Edit Copy Settings interface appears.
*Note: You can only modify the settings supported by the selected source and destination nodes in the
Edit Copy Settings interface.

Configuring Default Copy Settings
In the Default Copy Settings tab or the Edit Copy Settings interface under the Copy tab, make your
settings selections in the following fields:
1. Action – Select Attach to transfer the source node as a child node underneath the destination
node, or select Merge to add the content, securities, and configurations of the source node to
the destination node.
2. Promote Method – Choose to promote only the top-level site to the site collection or promote
all of the selected sites to site collections.
This section only appears when satisfying all of the following conditions:


In the Default Copy Settings tab, select Merge as the Action option.



In the Edit Copy Settings interface under the Copy tab, select the site collection level or
site level nodes in the source tree, select the Web application node in the destination
tree, and select Merge as the Action option.
*Note: When you select the site collection level nodes as the source, only the Promote
all sites to site collections option is available.

3. Which managed path would you like to use in the destination? –Select the Change the
managed path in destination checkbox to configure the managed path you are about to use in
20
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the destination by entering the desired value in the Enter an existing Wildcard Inclusion
Managed Path text box.
This section only appears when satisfying all of the following conditions:


In the Default Copy Settings tab, select Merge as the Action option.



In the Edit Copy Settings interface under the Copy tab, select the site collection level or
site level nodes in the source tree, select the Web application node in the destination
tree, and select Merge as the Action option.

4. Filter Policy – Select a filter policy from the drop-down list, or click New Filter Policy from the
drop-down list. Filter policies allow you to select specific objects or data within each SharePoint
level from site collection down to the item level. For information on creating a filter policy, see
the DocAve 6 Control Panel Reference Guide.
*Note: When using the filter policy in SharePoint Online, the Created By rule is not supported.
Exceptions will be recorded in the job report.
5. Configuration – Choose if you want to migrate configurations to the destination:


Select the Copy configuration checkbox to copy the properties, descriptions, titles,
settings, and features from the source node to the destination node. If you want to keep
the look and feel of the source site including the quick launch, top link bar, tree view,
site theme, and master page, select the Keep look and feel checkbox.
*Note: The Keep look and feel function will only take effect when the followings are in
place:
o

The source node is a site and the destination node is a top-level site or a site
collection.

o

Merge is selected as the action to take in the Action field.

Click Advanced and select the configurations that you want to copy:
o

Site Collection Level – Site collection features and properties.

o

Site Level – Site features and properties, Site column and content type,
Navigation and quick launch, Site template and list template, Web parts, page
layout, master pages and other hidden lists.
*Note: If you have selected the Keep look and feel checkbox, you cannot
deselect the checkboxes of the Site features and properties, Navigation and
quick launch, and Web parts, page layout, master pages and other hidden lists.

o

List Level – List settings and Public views.

*Note: In the Edit Copy Settings interface, the visibility of Site Collection Level, Site
Level, and List Level will change according to the selected Source node and Destination
node.

DocAve 6: Content Manager
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Leave the Copy configuration checkbox deselected if you do not want to migrate
configuration to the destination. Then, choose from the following options:
o

o

Select Copy the item-dependent columns and content types to maintain item
integrity. Then, select a conflict resolution method for these items’ columns and
content types from the drop-down list:


Do not copy the columns and content types, or the corresponding
items – Ignores the conflicting columns, content types, and
corresponding items, and do nothing on the source and destination
nodes.



Overwrite the columns and content types – Overwrites the destination
columns and content types with the source node.



Append the columns and content types to destination – Keeps the
destination columns and content types when there is a conflict. In
addition, copies the source columns and content types to the
destination node with a numerical suffix added (for example,
ColumnName_1, ColumnName_2, etc.).

Select Do not copy the item-dependent columns or content types. Report the
items if the corresponding column or content type is not found in destination.
The corresponding items are not copied to the destination. The job report will
show items if the corresponding column or content type is not found in the
destination node.

6. Security – Select the Copy security checkbox if you want to copy the user and/or group
permissions from the source node to the destination node, including SharePoint permission
level and permission inheritance of SharePoint objects. Additionally, select the Exclude
user/group without permission checkbox if you want to exclude users and/or groups that do
not have permissions.
*Note: The definition of users or groups without permission varies with the selected source
node:


If the source node is a site collection, the users or groups that meet the following two
conditions are the users or groups without permissions:
o

Users or groups that exist in the source node, but are not Site Collection
Administrators.

o

Users or groups that exist in the source node, but have no permissions to the
top-level site or any sites of the site collection.

*Note: If the source node is a Web application, the permissions of each site collection
are handled individually, and you can refer to the definition above.
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If the source node is a site, users or groups without permissions refer to the users or
groups that exist in the source node, but have no permissions to this site.
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If the source node is an object whose level is lower than the site level, users or groups
without permissions refer to the users or groups that exist in the source node, but have
no permissions to the site where the source object resides.

You cannot view these types of users or groups in the People and Groups – [SiteName]
Members page of a site, but you can view them in the People and Groups – All People page. To
go to the People and Groups – All People page, modify the value of MembershipGroupId in the
URL of the People and Groups – [SiteName] Members page to MembershipGroupId=0, then
you are brought to the People and Groups – All People page.
7. Content – Select the Copy content checkbox if you want to copy content in the libraries, folders,
and items from the source node to the destination node. Select Include list attachment if you
want to also copy the attached content in lists.
8. User Profile – Select the Copy user profile checkbox if you want to copy user profiles from the
source node to the destination node.
*Note: This function will only take effect when the source node level is equal to or higher than
the site collection level because users are saved in the top-level site.
9. Workflow – Select the Include workflow definition checkbox to copy the definition of existing
workflows for the selected content from the source node to the destination node. Select the
Include workflow instance to copy the state, history, and tasks of existing workflows for the
selected content. By default, the Include completed instance checkbox is selected to copy the
completed instance. You can select the Include running instance checkbox if you want to copy
the currently running instance in the source node to the destination node, and then select one
of the following radio buttons:


Cancel workflows – Cancel the copied or moved running workflow in the destination
node after the Content Manager jobs.



Restart workflows – Restart the copied or moved running workflow in the destination
node after the Content Manger jobs.

*Note: Content Manager does not support the workflow instances associated with checked-out
files.
10. Managed Metadata Service Setting – Select the Copy Managed Metadata Service checkbox if
you want to copy the related managed metadata services from the source node to the
destination node, and then select one of the following radio buttons:


Term – Copy terms that are used in the source, their parent terms, the term sets where
the used terms reside, and the names of the groups where the used terms reside to the
destination.



Term set – Copy the whole term sets where the used terms reside in the source
(regardless if the terms in the term sets are used by the source node or not) to the
destination.



Managed Metadata Service – Copy the whole Managed Metadata Services that are
related to the source node to the destination.
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11. Preserve the Null Column Values – Select Yes to preserve the null values of item columns (such
as newly created columns), or select No to replace null values with default values in the
destination node.
12. Folder Structure Management – Choose if you want to collapse the folder structure of the
copied or moved content. Select the Collapse Folder Structure checkbox to enable this feature.
DocAve also allows you to add a column to the destination for displaying the source folder path
or parent folder name. Select the Add a column to display the source folder path or parent
folder name checkbox to enable this feature as well.


Column to display the source folder path – Enter a column name in the text box to add
a Single Line of Text column to display the source folder path.



Column to display the parent folder name – Enter a column name in the text box to add
a Single Line of Text column to display the source parent folder name.

13. Data Compression – Select the Compression checkbox if you want to compress the data when it
is copied. If you choose to compress the data, use the slider to select the compression rate.
Fastest compression rates results in a larger data sets. Lower compression rates create smaller
better quality data sets, however the compression takes more time to perform.
*Note: Smaller data sets take longer to backup and recover.
14. Column Mapping – Maps source columns to the configured columns in the destination, or
change the column name to another one. The specified source columns will be mapped
according to the selected column type, and the column values will be mapped according to the
added value mappings. The column can also be changed to Managed Metadata or Lookup.
Select a column mapping from the drop-down list, or click New Column Mapping. For
information on creating a column mapping, see the DocAve 6 Control Panel Reference Guide.
*Note: If you select the column type Change to Lookup while setting up your column mapping,
make sure that the Lookup column can only be associated with the list or list column that exists
in the destination.
15. Content Type Mapping –Select a content type mapping from the drop-down list, or click New
Content Type Mapping. For information on creating a content type mapping, see the DocAve 6
Control Panel Reference Guide.
16. Template Mapping – Replaces site and list templates. By inputting or selecting a template ID,
the source template is changed to the destination template. Select a template mapping from
the drop-down list, or click New Template Mapping. For information on creating a template
mapping, see the DocAve 6 Control Panel Reference Guide.
17. User Mapping – Maps a source user to a target user. If the same user has a different username
in Domain A than in Domain B, or if you want to copy an individual user’s content, permissions,
and metadata in Domain A to another user in Domain B, the user’s permissions and metadata
will not be lost when content is moved. Select a user mapping from the drop-down list, or click
New User Mapping. For information on creating a user mapping, see the DocAve 6 Control
Panel Reference Guide.
18. Domain Mapping – Maps a source domain to a destination domain. The source domain name
will be replaced by the configured destination domain name, and the user in the source domain
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will be mapped to the destination user with the same login name. Select a domain mapping
from the drop-down list, or click New Domain Mapping. For information on creating a domain
mapping, see the DocAve 6 Control Panel Reference Guide.
19. Language Mapping – Displays the destination node in a different language than the source node
after the plan has been executed. Select a language mapping from the drop-down list, or click
New Language Mapping. For information on creating a language mapping, see the DocAve 6
Control Panel Reference Guide.
20. List Name Mapping – Changes the existing source lists of the copied or moved objects to your
designated lists in the destination. Select a list name mapping from the drop-down list, or click
New List Name Mapping. For information on creating a list name mapping, see the DocAve 6
Control Panel Reference Guide.
21. Backup Environment Before Running Plan – Select the Backup the destination environment
checkbox if you want to create a copy of the destination node prior to performing the copy. If
you choose to back up the destination environment before performing a copy, you must
designate a storage policy. Select the Backup the destination environment checkbox. The
Storage policy drop-down list appears. Select a storage policy from the drop-down list or click
New Storage Policy to create a new one.
*Note: Content Manager only supports the Backup type storage policy for the retention rule.
For more information on storage policies, see the DocAve 6 Control Panel Reference Guide.
22. Conflict Resolution – Choose Skip, Merge, or Replace from the Container level conflict
resolution drop-down list. Select the Check lower objects checkbox if you want to configure
content level conflict resolution, then choose Skip, Overwrite, Overwrite by Last Modified
Time, or Append from the Content level conflict resolution drop-down list. For detailed
information on how Content Manager resolves conflicts based on these configurations, see
Appendix A: Conflict Resolution.
23. Apps Conflict Resolution – Choose Skip, Update App Only, or Replace App and AppData from
the Apps conflict resolution drop-down list. For detailed information on how Content Manager
resolves apps conflicts based on these configurations, see Apps Conflict Resolution.
*Note: Apps Conflict Resolution only takes effect on the app instances.
24. Notification –Select a notification profile from the drop-down list. Click View beside the dropdown list to view details of the notification profile, or click New Notification Profile. For
information on creating a notification profile, see the DocAve 6 Control Panel Reference Guide.
In the Default Copy Settings tab, click Save to save these configurations and return to the Home tab of
Content Manager, or click Cancel.

Performing a Simple Copy
To perform a simple copy in Content Manager, select the node you want to copy from the Source pane,
and select the desired destination node from the Destination pane. You can use Advanced Search
functionality in the source and destination trees. For more information, refer to Using Advanced Search
in the Source and Destination Trees.
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*Note: For the SharePoint on-premises environment, make sure that the source node and the
destination node are in the same version of SharePoint. If the site within SharePoint 2013 is a site with
2010 experience version, it can only be copied to the site with the same experience version.
*Note: If the Record Declaration Settings in the destination node conflict with the Record Declaration
Settings in the source node, by default the Record Declaration Settings in the destination node will be
overwritten by the source node settings.
Click Copy on the ribbon, and then select Copy from the drop-down list. You will be brought to the Copy
tab. The Copy tab provides the following tools:


View – Click View on the ribbon if you want to review the copy settings.
*Note: If the selected source nodes or destination node is in the SharePoint onpremises environment, the Agent Group setting appears in the View tab. The Agent
group in the SharePoint on-premises environment will be loaded as the corresponding
Agent group to execute the simple copy.



Edit – Click Edit on the ribbon to make changes to the settings. You will be brought to
the Edit Copy Settings page. To configure the settings, refer to Configuring Default Copy
Settings.



Preview – Click Preview on the ribbon to see what the data tree of the destination node
will look like after the job is run. The source node is marked by a prompt message: From
Source.
*Note: This function supports Web application, site collection, and site level objects.



Run Now – Click Run Now on the ribbon. Your copy job will begin immediately, and you
will be brought back to the Home tab of Content Manager.



Cancel – Click Cancel on the ribbon to close the Copy tab without running the Copy job.

Moving Content
The following two sections explain how to configure Default Move Settings and perform a simple move
of content.
Use the Default Move Settings feature to customize a template for your move settings. These settings
will be applied to any new move jobs you create. You will be able to edit these settings before running
the move job. To configure default move settings, complete the following steps:
1. In the Home tab of the Content Manager interface, click Move on the ribbon.
2. Select Default Move Settings from the drop-down menu. The Default Move Settings tab
appears.
To edit the configured default move settings, complete the following steps:
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1. In the Home tab of the Content Manager interface, click Move on the ribbon.
2. Select Move from the drop-down menu. The Move tab appears.
3. Click Edit on the ribbon to edit the default copy settings. The Edit Move Settings interface
appears.
*Note: Before running a move job, you can only modify the settings supported by the selected source
and destination nodes in the Edit Move Settings interface.

Configuring Default Move Settings
In the Default Move Settings tab or the Edit Move Settings interface under the Move tab, make your
settings selections in the following fields:
1. Action – Select Attach to transfer the source node as a child node underneath the destination
node, or select Merge to add the content, securities, and configurations of the source node to
the destination node.
2. Promote Method – Choose to promote only the top-level site to the site collection or promote
all of the selected sites to site collections.
This section only appears when satisfying all of the following conditions:


In the Default Move Settings tab, select Merge as the Action option.



In the Edit Move Settings interface under the Move tab, select the site collection level
or site level nodes in the source tree, select the Web application node in the destination
tree, and select Merge as the Action option.
*Note: When you select the site collection level nodes as the source, only the Promote
all sites to site collections option is available.

3. Which managed path would you like to use in the destination? – Select the Change the
managed path in destination checkbox to configure the managed path you are about to use by
entering the desired value in the Enter an existing Wildcard Inclusion Managed Path text box.
This section only appears when satisfying all of the following conditions:


In the Default Copy Settings tab, select Merge as the Action option.



In the Edit Copy Settings interface under the Copy tab, select the site collection level or
site level nodes in the source tree, select the Web application node in the destination
tree, and select Merge as the Action option.

4. Filter Policy – Select a filter policy from the drop-down list, or click New Filter Policy. Filter
policies allow you to select specific objects or data within each SharePoint level from site
collection down to the item level. For information on creating a filter policy, see the DocAve 6
Control Panel Reference Guide.
*Note: When using the filter policy in SharePoint Online, the Created By rule is not supported.
Exceptions will be recorded in the job report.
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5. Configuration – Choose if you want to migrate the configurations to the destination:


Select the Move configuration checkbox to move the properties, descriptions, titles,
settings, and features from the source node to the destination node. If you want to keep
the look and feel of the source site including the quick launch, top link bar, tree view,
site theme, and master page, and then select the Keep look and feel checkbox.
*Note: The Keep look and feel function will only take effect when the followings are in
place:
o

The source node is a site and the destination node is a top-level site or a site
collection.

o

Merge is selected as the action to take in the Action field.

Click Advanced to select the configurations that you want to move:
o

Site Collection Level – Site collection features and properties.

o

Site Level – Site features and properties, Site column and content type,
Navigation and quick launch, Site template and list template, Web parts, page
layout, master pages and other hidden lists.
*Note: If you have selected the Keep look and feel checkbox, you cannot
deselect the checkboxes of the Site features and properties, Navigation and
quick launch, and Web parts, page layout, master pages and other hidden lists.

o

List Level – List settings and Public views.

*Note: In the Edit Copy Settings interface, the visibility of Site Collection Level, Site
Level, and List Level will change according to the selected Source node and Destination
node.


Leave the Move configuration checkbox deselected if you don’t want to migrate the
configuration to the destination. Then, choose from the following options:
o
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Select Move the item-dependent columns and content types to maintain item
integrity. Then, select a conflict resolution method for these items’ columns and
content types from the drop-down list:


Do not move the columns and content types, or the corresponding
items – Ignores the conflicting columns, content types, and the
corresponding items, and do nothing on the source and destination
node.



Overwrite the columns and content types – Overwrites the destination
columns and content types with the source node.



Append the columns and content types to destination – Keeps the
destination columns and content types when there is a conflict. In
addition, copies the source columns and content types to the
destination node with a numerical suffix added (for example,
ColumnName_1, ColumnName_2, etc.).
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o

Select Do not move the item-dependent columns or content types. Report the
items if the corresponding column or content type is not found in destination.
The corresponding items are not moved to the destination. DocAve will report
the items if the corresponding column or content type is not found in the
destination node.

6. Security – Select the Move security checkbox to move the user and/or group permissions from
the source node to the destination node, including SharePoint permission level and permission
inheritance of SharePoint objects. Select the Exclude user/group without permission checkbox
to not copy users and/or groups that have no permissions.
*Note: The definition of users or groups without permission varies with the selected source
node:


If the source node is a site collection, the users or groups that meet the following two
conditions do not have permissions:
o

Users or groups that exist in the source node, but are not Site Collection
Administrators.

o

Users or groups that exist in the source node, but have no permissions to any
sites of the site collection.

*Note: If the source node is a Web application, the permissions of each site collection
are handled individually, and you can refer to the definition above.


If the source node is a site, users or groups without permissions refer to the users or
groups that exist in the source node, but have no permissions to this site.



If the source node is an object whose level is lower than the site level, users or groups
without permissions refer to the users or groups that exist in the source node, but have
no permissions to the site where the source object resides.

You cannot view these types of users or groups in the People and Groups – [SiteName]
Members page of a site, but you can view them in the People and Groups – All People page. To
go to the People and Groups – All People page, modify the value of MembershipGroupId in the
URL of the People and Groups – [SiteName] Members page to MembershipGroupId=0. You will
be brought to the People and Groups – All People page.
7. Content – Select the Move content checkbox to move content in libraries, folders, and items
from the source node to the destination node. Select the Include list attachment to also move
the attached content in lists.
8. User Profile – Select the Move user profile checkbox to move user profiles from the source
node to the destination node.
9. Workflow – Select the Include workflow definition checkbox to move the definition of the
existing workflows for the selected content and/or select the Include workflow instance to
move the state, history, and tasks of existing workflows for the selected content. By default, the
Include completed instance checkbox is selected to copy the completed instance from the
source node to the destination node. You can select the Include running instance checkbox if
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you want to copy the currently running instance, and then select one of the following radio
buttons:


Cancel workflows – Cancel the copied or moved running workflow in the destination
node after the Content Manager jobs.



Restart workflows – Restart the copied or moved running workflow in the destination
node after the Content Manger jobs.

*Note: Content Manager does not support the workflow instances associated with checked-out
files.
10. Managed Metadata Service Setting – Select the Copy Managed Metadata Service checkbox if
you want to copy the related managed metadata services from the source node to the
destination node, and then select one of the following radio buttons:


Term – Copy terms that are used in the source, their parent terms, the term sets where
the used terms reside, and the names of the groups where the used terms reside to the
destination.



Term set – Copy the whole term sets where the used terms reside in the source
(regardless if the terms in the term sets are used by the source node or not) to the
destination.



Managed Metadata Service – Copy the whole Managed Metadata Services that are
related to the source node to the destination.

11. Preserve the Null Column Values – Select Yes to preserve the null values of item, or select No to
replace null values with default values in the destination node.
12. Folder Structure Management – Choose if you want to collapse the folder structure of the
copied or moved content. Select the Collapse Folder Structure checkbox to enable this feature.
DocAve also allows you to add a column to the destination for displaying the source folder path
or parent folder name. Select the Add a column to display the source folder path or parent
folder name checkbox to enable this feature as well.


Column to display the source folder path – Enter a column name in the text box to add
a Single Line of Text column to display the source folder path.



Column to display the parent folder name – Enter a column name in the text box to add
a Single Line of Text column to display the source parent folder name.

13. Data Compression – Select the Compression checkbox if you want to compress the data when it
is moved. If you choose to compress the data, use the slider to select the compression rate.
Fastest compression rate results in a larger data set. Best compression rate results in a Slower
Compression rates result in smaller, better quality data sets.
*Note: Smaller data sets take longer to backup and recover.
14. Column Mapping – Maps source columns to the configured columns in the destination, or
change the column name. The selected source columns will be mapped according to the
selected column type, and the column values will be mapped according to the added value
mappings. The column can also be changed to Managed Metadata or Lookup. Select a column
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mapping from the drop-down list, or click New Column Mapping. For information on creating a
column mapping, see the DocAve 6 Control Panel Reference Guide.
*Note: If you select the column type Change to Lookup while setting up your column mapping,
make sure that the Lookup column can only be associated with the list or list column that exists
in the destination.
15. Content Type Mapping –Select a content type mapping from the drop-down list, or click New
Content Type Mapping. For information on creating a content type mapping, see the DocAve 6
Control Panel Reference Guide.
16. Template Mapping – Replaces site and list templates. By inputting or selecting a template ID,
the source template is changed to the destination template. Select a template mapping from
the drop-down list, or click New Template Mapping. For information on creating a template
mapping, see the DocAve 6 Control Panel Reference Guide.
17. User Mapping – Maps a source user to a target user. If the same user has a different username
in Domain A than in Domain B, or if you want to move an individual user’s content, permissions,
and metadata in Domain A to another user in Domain B, the user’s permissions and metadata
will not be lost when content is moved. Select a user mapping from the drop-down list, or click
New User Mapping. For information on creating a user mapping, see the DocAve 6 Control
Panel Reference Guide.
18. Domain Mapping – Maps a source domain to a destination domain. The source domain name
will be replaced by the configured destination domain name, and the user in the source domain
will be mapped to the destination user which has the same login name. Select a domain
mapping from the drop-down list, or click New Domain Mapping. For information on creating a
domain mapping, see the DocAve 6 Control Panel Reference Guide.
19. Language Mapping – Displays the destination node in a different language than source node
after the plan has been executed. Select a language mapping from the drop-down list, or click
New Language Mapping. For information on creating a language mapping, see the DocAve 6
Control Panel Reference Guide.
20. List Name Mapping – Changes the existing source lists of the copied or moved objects to your
designated lists in the destination. Select a list name mapping from the drop-down list, or click
New List Name Mapping. For information on creating a list name mapping, see the DocAve 6
Control Panel Reference Guide.
21. Source Deletion Method – Select Manual to delete the source content once the job is complete.
To delete it manually, select the move job in Job Monitor, then click Delete on the ribbon and
select Delete Content from the drop-down list. Select Automatic to have DocAve delete the
source content.
22. Delete Source Checked Out Documents – Select Yes to have DocAve delete the checked out
documents which are not checked out by the Agent account on the source node when the
source content is deleted. By default, No is selected, which means the checked out documents
that are not checked out by the Agent account will not be deleted on the source. DocAve will
delete the checked out documents that are checked out by the Agent account regardless of the
selection of Delete Source Checked Out Documents option when the source content is deleted.
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23. Backup Environment Before Running Plan – Select the Backup the source environment
checkbox if you want to create a copy of the source node prior to performing the. If you choose
to back up the source and/or destination environment before performing a copy, you must
designate a storage policy. Select storage policy or click New Storage Policy.
*Note: Content Manager only supports the Backup type storage policy for retention rule. For
more information on storage policies, see the DocAve 6 Control Panel Reference Guide.
*Note: The source node is deleted as the second step in a move job. If Backup the source
environment is not selected, you will not be able to restore the source node to its state prior to
the move job.
24. Conflict Resolution – Choose Skip, Merge or Replace from the Container level conflict
resolution drop-down list. Select the Check lower objects checkbox to configure content level
conflict resolution, then choose Skip, Overwrite, Overwrite by Last Modified Time, or Append
from the Content level conflict resolution drop-down list. For detailed information on how
Content Manager resolves conflicts based on these configurations, see Appendix A: Conflict
Resolution.
25. Apps Conflict Resolution – Choose Skip, Upgrade App Only, or Replace App and AppData from
the Apps conflict resolution drop-down list. For detailed information on how Content Manager
resolves apps conflicts based on these configurations, refer to Apps Conflict Resolution.
*Note: Apps Conflict Resolution only takes effect on the app instances.
26. Notification –Select a notification profile from the drop-down list. Click View beside the dropdown list to view details of the notification profile, or click New Notification Profile. For
information on creating a notification profile, see the DocAve 6 Control Panel Reference Guide.
27. In the Default Move Settings tab, click Save to save these configurations and return to the
Home tab of Content Manager, or click Cancel.

Performing a Simple Move
To perform a simple move in Content Manager, select the node you want to move from the Source
pane, and select the destination node from the Destination pane. You can use the Advanced Search
functionality in the source and destination trees. For more information, refer to Using Advanced Search
in the Source and Destination Trees.
*Note: For the SharePoint on-premises environment, make sure that the source node and the
destination node are in the same version of SharePoint. If the site within SharePoint 2013 is a
SharePoint 2010 mode site, it can only be moved to the same mode site.
*Note: If the Record Declaration Settings in the destination node conflict with the Record Declaration
Settings in the source node, by default the Record Declaration Settings in the destination node will be
overwritten by the source node settings. The records that have been blocked from deletion in the
source node will not be deleted after the Move job.
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Click Move on the ribbon, and then select Move from the drop-down list. You will be brought to the
Move tab. The Move interface provides the following tools:


View – Click View on the ribbon to review your settings.
*Note: If the selected source nodes or destination node is in the SharePoint onpremises environment, the Agent Group setting appears in the View tab. The Agent
group in the SharePoint on-premises environment will be loaded as the corresponding
Agent group to execute the simple move.



Edit – Click Edit on the ribbon to make changes to the move settings. You will be
brought to the Edit Move Settings page. To configure the settings in the Edit Move
Settings interface, refer to Configuring Default Move Settings.



Preview – Click Preview on the ribbon to see what the data tree of the destination node
will look like after the move job is run. The source node is marked by a prompt message:
From Source.
*Note: The preview function supports Web application, site collection, and site level
objects.



Run Now – Click Run Now on the ribbon to execute the move job. Your move job will
begin immediately, and you will be brought back to the Home tab of Content Manager.



Click Cancel on the ribbon to close the Move tab without running the Move job.

Creating Containers
Use the Create Container feature to create containers in SharePoint without leaving the DocAve
interface. This feature allows you to continue performing content management tasks without having to
create all of the necessary containers before using Content Manager.
*Note: Create Container can be used to create site collections, sites, lists, and folders in the SharePoint
on-premises environments. You can create sites, lists, and folders in the SharePoint Online
environments.
*Note: If the destination farm is a FBA or ADFS farm, when manually creating a site collection, a pop-up
window will appear to let you select the administrator of the site collection you are about to create.
To create a container, enter the name of a new container in the available field in the Destination pane,
and then click Create Container. The Create Container interface appears. Configure the settings for each
type of container according to the following sections.
*Note: When creating a folder, you do not need to configure the settings. When you click Create
Container at the folder level, you will create a folder immediately.
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Creating a Site Collection
Configure these settings on the Create Container interface:
1. Title and Description – Enter the Title of the new site collection, and an optional description.
2. Web Site Address – Displays the URL of the site collection you are about to create.
3. Template Selection – Select the desired language from the Select a language drop-down list,
and then select a site template for this new site collection. Click on a tab to access the templates
listed in that category, or click on the Custom tab and select <Select Template Later …> to not
choose a template upon creation.
4. Primary Site Collection Administrator – Enter the Username of the primary administrator for
this site collection.
5. Secondary Site Collection Administrator – Enter the Username of the secondary administrator
for this site collection.
6. Quota Template – Select the storage quota template to apply to this site collection. To add a
new quota template, click the Manage Quota Templates link. The Manage Quota Templates
interface appears. Configure the following settings:
a. Template Name – Edit an existing quota template or create a new template.
o

Edit an existing template – Select this radio button if you want to edit an
existing quota template. You can only edit the Personal Site here.

o

Create a new quota template – Select this radio button if you want to create a
new quota template.


Template to start from – Select [New Blank Template] or Personal Site
from the drop-down list.



New template name – Enter a name for the new template.

b. Storage Limit Values – Choose if you want to limit the amount of storage available on a
site collection. Set the maximum amount of storage and a warning level. When the
warning level or maximum storage level is reached, an email alert is sent to the site
administrators to inform them of the issue.
o

Limit site storage to a maximum of _MB – Enter a positive integer less than 1
terabyte in the text box.

o

Send warning e-mail when site collection storage reaches _MB – Enter a
positive integer smaller than the entered maximum storage quota.

c. Sandboxed Solutions with Code Limits – Choose if you want sandboxed solutions with
code for this site collection. When the warning level is reached, an email alert is sent.
When the maximum usage limit is reached, sandboxed solutions with code are disabled
for the rest of the day and an email alert is sent to the site administrator.
o
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Limit maximum usage per day to _points – Enter a positive integer less than 1
million in the text box.
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o

Send warning e-mail when usage per day reaches _points – Enter a positive
integer less than or equal to the maximum usage.

d. Click Save to save your configurations and return to the Create Container interface or
click Cancel to return to the Create Container interface without saving any changes.
7. Content Database – Select the content database for this site collection.
8. Click Save to create the new site collection, or click Cancel to close the Create Container
interface.

Creating a Site
Configure these settings on the Create Container interface:
1. Title and Description – Enter the Title of the new site, and an optional description.
2. Web Site Address – Displays the URL of the site you are about to create.
3. Template Selection – Select the desired language from the Select a language drop-down list,
and then select a site template for this new site. Click on a tab to access the templates listed in
that category.
4. Permissions – Select Use unique permissions to allow a unique set of users access to this new
site, or select Use same permissions as parent site to allow the same users who can access the
parent site to access this new site.
5. Navigation – Select the Yes or No radio button to determine whether or not to display this site
on the Quick Launch and the top link bar of the parent site.
6. Navigation Inheritance – Select the Yes or No radio button to determine whether or not use the
top link bar from the parent site.
7. Click Save to create the new site, or click Cancel to close the Create Container interface.

Creating a List/Library
Configure these settings in the Create Container interface:
1. Object Type – Choose if you want to create a List or a Library.
2. Category – Select the category type for the new list or library from the drop-down list.
3. Navigation– Determine if you want to display this list or library on the Quick Launch.
4. Click Save, or click Cancel to close the Create Container interface.

Using Advanced Search in the Source and Destination Trees
If working with a large SharePoint environment, use Advanced Search in the destination tree to find the
desired node by completing the following steps:
1. In the Source or Destination pane, click the farm name to expand the data tree.
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2. Right-click a farm level node, a Web application level node, the Lists virtual node, the Sites
virtual node, or the Folders virtual node.
3. Select Advanced Search from the drop-down menu. The Advanced Search interface appears.
4. Customize the filter rules and conditions.
a. Click Add a Criterion to add a new filter condition.
b. If you have multiple filter conditions, click And or Or in the And/Or column to change
the logical relationship among the filter conditions.
c. Hover over a previously added filter condition.
d. Click the delete (

) button to delete the filter condition.

5. Click Search to start the search, or click Cancel to exit the Advanced Search interface without
saving any configurations.
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Building Plans
In Content Manager, you can create plans to copy or move content so that you can repeat the process
without having to reconfigure all of the settings. Plans also allow you the flexibility of performing the job
at a scheduled time. You can create plans in one of the following two ways:


Wizard Mode – For users who are not familiar with creating Content Manager plans,
Wizard Mode provides step-by-step guidance when creating a plan.



Form Mode – For more advanced users, Form Mode provides more flexibility in which
settings you configure first.

Building Plans Using Wizard Mode
To create a plan using Wizard Mode, click Online Content Manager on the ribbon in the Home tab to
enter the online mode. Then select the source node in the Source pane, and select the destination node
in the Destination pane.
*Note: For the SharePoint on-premises environment, make sure that the source node and the
destination node are in the same version of SharePoint. If the site within SharePoint 2013 is a site with
2010 experience version, it can only be copied or moved to the site with the same experience version.
*Note: When selecting My Site in the Source pane, make sure that the application pool account of the
destination Web application meets the following conditions:


Is the Administrator of the User Profile Service currently in use.



Has Full Control permission to the User Profile Service currently in use.

Click Plan Builder on the ribbon, and then select Wizard Mode from the drop-down menu. You will be
brought to the Wizard Mode tab. To create your plan, complete the following steps:
1. Plan Name – Enter the new Plan Name, and an optional description. Click Next.
2. Method – Configure the method and action for this plan:
a. Method – Select Copy or Move for the type of job you want Content Manager to run
when this plan is executed. If you select Move, you may also configure the following
settings:
o

Source Deletion Method – Select Manual to delete the source content yourself
once the copy/move job is complete (select the copy/move job in Job Monitor,
then click Delete on the ribbon and select Delete Content from the drop-down
list), or select Automatic to have DocAve delete the source content once the
copy/move job is complete.

o

Delete Source Checked Out Documents – Select Yes if you want to have DocAve
delete the checked out documents which are not checked out by the Agent
account on the source node when source content is deleted. By default, No is
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selected, which means the checked out documents which are not checked out
by the Agent account will not be deleted on the source. DocAve will delete the
checked out documents that are checked out by the Agent account regardless of
the selection of Delete Source Checked Out Documents option when the source
content is deleted.
b. Action – Select Attach to transfer the source node as a child node underneath the
destination node, or select Merge to add the content, securities, and configurations of
the source node to the destination node. To see what the data tree of the destination
node will look like after the job is executed, click Show Preview. The source node is
marked by a prompt message: From Source.
c. Promote Method – Choose to promote only the top-level site to the site collection or
promote all of the selected sites to site collections. This section only appears when
satisfying all of the following conditions:
o

Select site collection level or site level nodes in the source tree and select the
Web application node in the destination tree.
*Note: When you select site collection level nodes as the source, only the
Promote all sites to site collections option is available.

o

Select Merge as the Action option.

d. Which managed path would you like to use in the destination? – Changes the managed
path in the destination. Select the Change the managed path in destination checkbox to
configure the managed path you are about to use by entering the desired value in the
Enter an existing Wildcard Inclusion Managed Path text box. This section only appears
when satisfying all of the following conditions:
o

Select site collection level or site level nodes in the source tree and select the
Web application node in the destination tree.

o

Select Merge as the Action option.

3. When you have finished configuring the method for this plan, click Next.
4. Data Selection – Configure the following settings:
a. Filter Policy – Select a filter policy from the drop-down list, or click New Filter Policy.
Filter policies allow you to select specific objects or data within each SharePoint level
from site collection down to the item level. For information on creating a filter policy,
see the DocAve 6 Control Panel Reference Guide.
*Note: When using the filter policy in SharePoint Online, the Created By rule is not
supported. Exceptions will be recorded in the job report.
b. Configuration – Choose if you want to migrate the configurations to the destination:
o
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Select the Copy/Move configuration checkbox to copy or move the properties,
descriptions, titles, settings, and features from the source node to the
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destination node. If you want to keep the look and feel of the source site
including the quick launch, top link bar, tree view, site theme, and master page,
and then select the Keep look and feel checkbox.
*Note: The Keep look and feel function will only take effect when the followings
are in place:


The source node is a site, the destination node is a top-level site or a
site collection.



Merge is selected as the action to take in the Action field.

Click Advanced to select the configurations that you want to copy or move:


Site Collection Level – Site collection features and properties.



Site Level – Site features and properties, Site column and content type,
Navigation and quick launch, Site template and list template, Web parts,
page layout, master pages and other hidden lists.
*Note: If you have selected the Keep look and feel checkbox, you
cannot deselect the checkboxes of the Site features and properties,
Navigation and quick launch, and Web parts, page layout, master
pages and other hidden lists.



List Level – List settings and Public views.

*Note: In the Edit Copy Settings interface, the visibility of Site Collection Level,
Site Level, and List Level will change according to the selected Source node and
Destination node.
o

Leave the Copy/Move configuration checkbox deselected if you don’t want to
migrate the configuration to the destination. For more information on how to
configure the Configuration section, refer to Configuring the Configuration
Section.

c. Security – Select the Copy/Move security checkbox to copy or move the user and/or
group permissions from the source node to the destination node, including SharePoint
permission level and permission inheritance of SharePoint objects. Select the Exclude
user/group without permission checkbox to not copy or move users and/or groups that
have no permissions.
*Note: The definition of users or groups without permission varies with the selected
source node:
o

If the source node is a site collection, the users or groups that meet the
following two conditions are the users or groups without permissions:
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Users or groups that exist in the source node, but are not Site Collection
Administrators.
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Users or groups that exist in the source node, but have no permissions
to the top-level site or any sites of the site collection.

*Note: If the source node is a Web application, the permissions of each site
collection are handled individually, and you can refer to the definition above.
o

If the source node is a site, users or groups without permissions refer to the
users or groups that exist in the source node, but have no permissions to this
site.

o

If the source node is an object whose level is lower than the site level, users or
groups without permissions refer to the users or groups that exist in the source
node, but have no permissions to the site where the source object resides.

You cannot view these types of users or groups in the People and Groups – [SiteName]
Members page of a site, but you can view them in the People and Groups – All People
page. To go to the People and Groups – All People page, modify the value of
MembershipGroupId in the URL of the People and Groups – [SiteName] Members page
to MembershipGroupId=0. You will be redirected to the People and Groups – All
People page.
d. Content – Select the Copy/Move content checkbox to copy/move content in libraries,
folders and items from the source node to the destination node. Select the Include list
attachment to also copy/move attached content in lists.
e. User Profile – Select the Copy/Move user profile checkbox if you want to move user
profiles from the source node to the destination node.
*Note: This section will only appear if the source node level is equal to or higher than
the site collection level because users are saved in the top-level site.
f.

Workflow – Select the Include workflow definition checkbox to copy/move the
definition of existing workflows for the selected content from the source node to the
destination node. Select the Include workflow instance to copy/move the state, history
and tasks of existing workflows for the selected content from the source node to the
destination node. By default, the Include completed instance checkbox is selected. You
can select Include running instance checkbox if you want to copy the currently running
instance in the source node to the destination node, and then select one of the
following radio buttons:
o

Cancel workflows – Cancel the copied or moved running workflows in the
destination node after the Content Manager jobs.

o

Restart workflows – Restart the copied or moved running workflows in the
destination node after the Content Manger jobs.

*Note: Content Manager does not support the workflow instances associated with
checked-out files.
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g. Managed Metadata Service Setting – Select the Copy Managed Metadata Service
checkbox if you want to copy the related managed metadata services from the source
node to the destination node, and then select one of the following radio buttons:
o

Term – Copy terms that are used in the source, their parent terms, the term sets
where the used terms reside, and the names of the groups where the used
terms reside to the destination.

o

Term set – Copy the whole term sets where the used terms reside in the source
(regardless if the terms in the term sets are used by the source node or not) to
the destination.

o

Managed Metadata Service – Copy the whole Managed Metadata Services that
are related to the source node to the destination.

5. When you have finished configuring the data selection settings, click Next.
6. Schedule – Configure a schedule for this plan:




If you selected Copy in the Method section, choose one of the following options:
o

Select No Schedule to manually execute this plan.

o

Select Start Time if you want to have the plan executed at a selected time. If
applicable, you can change the time zone by clicking on the hyperlink to select a
different time zone.

If you selected Move in the Method section, choose one of the following options:
o

Select No Schedule to manually execute this plan.

o

Select Configure the schedule myself to determine the frequency to run this
recurring schedule. Configure the following sections:


Start time – Select the time when this plan is executed.



Interval – Specify the interval for this plan.



No end date – The Move jobs will run on a configured schedule until
you manually end it.



End after __occurrences – The Move jobs will stop running after the
number of times you select here.



End by __– The Move jobs will end on the date and time you enter
here.

7. When you have finished configuring the schedule, click Next.
8. Advanced – Configure the following advanced settings:
a. Preserve the Null Column Values – Select Yes to preserve the null values of item
columns, or select No to replace null values with default values in the destination node.
b. Folder Structure Management – Choose if you want to collapse the folder structure of
the copied or moved content. Select the Collapse Folder Structure checkbox to enable

DocAve 6: Content Manager

41

this feature. DocAve also allows you to add a column to the destination for displaying
the source folder path or parent folder name. Select the Add a column to display the
source folder path or parent folder name checkbox to enable this feature. .
o

Column to display the source folder path – Enter a column name in the text box
to add a Single Line of Text column to display the source folder path.

o

Column to display the parent folder name – Enter a column name in the text
box to add a Single Line of Text column to display the source parent folder
name.
*Note: This section only appears when you selected list or folder level nodes in
the source tree.

c. Data Compression – Select the Compression checkbox if you want to compress the data
when it is copied. If you choose to compress the data, use the slider to select the
compression rate. Faster compression rate results in larger data sets. The best
compression rate is a smaller, better quality data set. However, the compression takes
more time to perform.
*Note: Smaller data sets take longer to backup and recover.
d. Column Mapping – Maps source columns to the configured columns in the destination,
or change the column name to another one. The source columns will be mapped
according to the selected column type, and the column values will be mapped according
to the added value mappings. According to the column type, the source column and the
destination column can be the same or different. The column can also be changed to
Managed Metadata or Lookup. Select a column mapping from the drop-down list, or
click New Column Mapping. For information on creating a column mapping, see the
DocAve 6 Control Panel Reference Guide.
*Note: If you select the column type Change to Lookup while setting up your column
mapping, make sure that the Lookup column can only be associated with the list or list
column that exists in the destination.
e. Content Type Mapping – Maps source content types to the configured content types in
destination, or change the content type name to another one, according to the
condition that you set up. Select a content type mapping from the drop-down list, or
click New Content Type Mapping. For information on creating a content type mapping,
see the DocAve 6 Control Panel Reference Guide.
*Note: Make sure that the source content type and the destination content type are
compatible.
f.
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Template Mapping – Replaces site and list templates. By inputting or selecting a
template ID, the source template is changed to the destination template. Select a
template mapping from the drop-down list, or click New Template Mapping. For
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information on creating a template mapping, see the DocAve 6 Control Panel Reference
Guide.
g. User Mapping – Replaces an existing source node username with an existing destination
node username or a default username in the destination. You can also add a place
holder account to keep user metadata even if the user no longer exists. Select a user
mapping from the drop-down list, or click New User Mapping. . For information on
creating a user mapping, see the DocAve 6 Control Panel Reference Guide.
h. Domain Mapping – Maps a source domain to a destination domain. The source domain
name will be replaced by the configured destination domain name, and the user in the
source domain will be mapped to the destination user which has the same login name.
Select a domain mapping from the drop-down list, or click New Domain Mapping. For
information on creating a domain mapping, see the DocAve 6 Control Panel Reference
Guide.
i.

Language Mapping – Choose if you want to display destination node in a different
language other than source node after the plan has been executed. Select a language
mapping from the drop-down list, or click New Language Mapping. For information on
creating a language mapping, see the DocAve 6 Control Panel Reference Guide.

j.

List Name Mapping – Choose if you want to change the existing source lists of the
copied or moved objects to your designated lists in the destination. Select a list name
mapping from the drop-down list, or click New List Name Mapping. For information on
creating a list name mapping, see the DocAve 6 Control Panel Reference Guide.

k. Backup Environment Before Running Plan – Choose from the following configurations:
o

Select the Backup the source environment checkbox to create a copy of the
source node prior to performing the move. This is only when moving jobs.

o

Select the Backup the destination environment checkbox to create a copy of
the destination node prior to performing the copy. If you choose this option,
you must designate a storage policy. Select a storage policy or click New Storage
Policy to create a new one.
*Note: Content Manager only supports the Backup type storage policy for
retention rule. For more information on storage policies, see the DocAve 6
Control Panel Reference Guide.

l.

Conflict Resolution – Choose Skip, Merge, or Replace from the Container level conflict
resolution drop-down list. Select the Check lower objects checkbox if you want to
configure content level conflict resolution, then choose Skip, Overwrite, Overwrite by
Last Modified Time, or Append from the Content level conflict resolution drop-down
list. For detailed information on how Content Manager resolves conflicts based on these
configurations, see Appendix A: Conflict Resolution.
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m. Apps Conflict Resolution – Choose Skip, Upgrade App Only, or Replace App and
AppData from the Apps conflict resolution drop-down list. This only appears when the
selected source and destination nodes are in the SharePoint 2013 environments. For
detailed information on how Content Manager resolves apps conflicts based on these
configurations, see Apps Conflict Resolution.
*Note: Apps Conflict Resolution only takes effect on the app instances.
n. Agent Group – Select a source or a destination Agent group to execute the Content
Manager job.
o

Source Agent Group – Select a source Agent group to back up the data in the
selected source nodes. This option only appears when the selected source node
are in the SharePoint on-premises environments.

o

Destination Agent Group – Select a destination Agent group to restore the
backed up source data to the destination node. This option only appears when
the selected destination node is in the SharePoint on-premises environment.

o. Notification – Choose the type of notification report and designate which DocAve user
will receive the email notification. Select a notification profile from the drop-down list.
Click View beside the drop-down list to view details of the notification profile, or click
New Notification Profile. For information on creating a notification profile, see the
DocAve 6 Control Panel Reference Guide.
p. Associated Plan Group – Adds the plan to one or more plan groups to manage the plans
with common settings. Select a plan group ted from the drop-down list, or click New
Plan Group. For information on creating a plan group, see the DocAve 6 Control Panel
Reference Guide.
9. When you have finished configuring the advanced settings, click Next.
10. Overview – Once you have finished configuring this plan, you can review and edit the various
settings for this plan. In the Settings tab of the Overview pane, click Edit in any section to make
changes to the settings in that section. In the Preview tab, click Show Preview to see what the
data tree of the destination will look like after the job is run. The source node is marked by a
prompt message: From Source.
11. After you have reviewed all of the settings and scopes in the Overview pane, click Finish on the
ribbon, and then select Finish from the drop-down list to save the plan. To save the plan and
execute it right away, click Finish on the ribbon, and then select Finish and Run Now from the
drop-down list.
12. At any time, click Cancel on the ribbon to return to the Home tab of Content Manager.
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Configuring the Configuration Section
Refer to this section on how to configure the Configuration section. After deselecting the Copy/Move
configuration checkbox, choose from the following options:




Select Copy/Move the item-dependent columns and content types to maintain item
integrity. Then, select a conflict resolution method for these items’ columns and
content types from the drop-down list:
o

Do not copy/move the columns and content types, or the corresponding items
– Ignores the conflicting columns, content types, and the corresponding items,
and do nothing on the source and destination node.

o

Overwrite the columns and content types – Overwrites the destination
columns and content types with the source node.

o

Append the columns and content types to destination – Keeps the destination
columns and content types when there is a conflict. Copies the source columns
and content types to the destination node with a numerical suffix added (for
example, ColumnName_1, ColumnName_2, etc.).

Select Do not copy/move the item-dependent columns or content types. The
corresponding item-dependent columns or content types are not copied/moved to the
destination. If the item-dependent columns or content types do not exist in the
destination, the items will not be copied/moved to the destination. If the itemdependent columns or content types already exist in the destination, the items will be
copied/moved to the destination. The job report will show items if the corresponding
column or content type is not found in the destination node.

Building Plans Using Form Mode
To create a plan using Form Mode, click Online Content Manager on the ribbon in the Home tab. Select
the source node in the Source pane, and select a destination node in the Destination pane.
*Note: For the SharePoint on-premises environment, make sure that the source node and the
destination node are in the same version of SharePoint. If the site within SharePoint 2013 is a
SharePoint 2010 mode site, it can be copied or moved to the same on-premises mode site, or a
SharePoint Online site.
*Note: When selecting My Site in the Source pane, make sure that the application pool account of the
destination Web application meets the following conditions:


Is the Administrator of the User Profile Service currently in use.



Has Full Control permission to the User Profile Service currently in use.

Click Plan Builder on the ribbon, and then select Form Mode from the drop-down list. You will be
redirected to the Form Mode tab. To create your plan, complete the following steps:
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1. Plan Name – Enter the new Plan Name, then enter an optional description. Click Next.
2. Method – Select Copy or Move for the type of job you want to run. If you select Move, you may
also configure the following settings:


Source Deletion Method – Select Manual to delete the source content yourself once
the copy/move job is complete (select the copy/move job in Job Monitor, then click
Delete on the ribbon and select Delete Content from the drop-down list), or select
Automatic to have DocAve delete the source content once the job is complete.



Delete Source Checked Out Documents – Select Yes if you want to have DocAve delete
the checked out documents which are not checked out by the Agent account on the
source node when source content is deleted. By default, No is selected, which means
the checked out documents which are not checked out by the Agent account will not be
deleted on the source. DocAve will delete the checked out documents which are
checked out by the Agent account regardless of the selection of Delete Source Checked
Out Documents option when the source content is deleted.

3. Action – Select Attach to transfer the source node as a child node underneath the destination
node, or select Merge to add the content, securities, and configurations of the source node to
the destination node. To see what the data tree of the destination node will look like after the
job is executed, click Show Preview.
4. Promote Method – Choose to promote only the top-level site to the site collection or promote
all of the selected sites to site collections. This section only appears when satisfying all of the
following conditions:


Select site collection level or site level nodes in the source tree and select the Web
application node in the destination tree.
*Note: When you select site collection level nodes as the source, only the Promote all
sites to site collections option is available.



Select Merge as the Action option.

5. Which managed path would you like to use in the destination? – Select the Change the
managed path in destination checkbox to configure the managed path you are about to use by
entering the desired value in the Enter an existing Wildcard Inclusion Managed Path text box.
This section only appears when satisfying all of the following conditions:


Select site collection level or site level nodes in the source tree and select the Web
application node in the destination tree.



Select Merge as the Action option.

6. Backup Environment Before Running Plan – Configure the following configurations:

46



Select the Backup the source environment checkbox to create a copy of the source
node prior to performing the move. This option only appears for move jobs.



Select the Backup the destination environment checkbox to create a copy of the
destination node prior to performing the copy. If you choose to back up the destination
environment before performing a copy, you must designate a storage policy. Select a
storage policy or click New Storage Policy to create a new one.
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*Note: Content Manager only supports the Backup type storage policy for retention
rule. For more information on storage policies, see the DocAve 6 Control Panel
Reference Guide.
7. Schedule – Configure a schedule for this plan:




If you selected Copy in the Method section, choose one of the following options:
o

Select No Schedule to manually execute this plan.

o

Select Start Time to have this plan execute at a specified time. You may change
the time zone by clicking on the hyperlink next to Start Time.

If you selected Move in the Method section, choose one of the following options:
o

Select No Schedule to manually execute this plan.

o

Select Configure the schedule myself to specify the frequency to run this
recurring schedule. Configure the following settings:


Start time – Specify the time when this plan is executed.



Interval – Select the interval for this plan.



No end date – The Move jobs will run on a configured schedule until
you manually end it.



End after __occurrences – The Move jobs will stop running after the
number of times you enter here.



End by __– The Move jobs will end on the date and time you specify
here.

8. Click Advanced to configure more options.
9. Filter Policy – Select a filter policy from the drop-down list, or click New Filter Policy. Filter
policies allow you to select specific objects or data within each SharePoint level from site
collection down to the item level. For information on creating a Filter Policy, see the DocAve 6
Control Panel Reference Guide.
*Note: When using the filter policy in SharePoint Online, the Created By rule is not supported.
Exceptions will be recorded in the job report.
10. Configuration – Choose if you want to migrate the configurations to the destination:


Select the Copy/Move configuration checkbox to copy/move the properties,
descriptions, titles, settings, and features from the source node to the destination node.
If you want to keep the look and feel of the source site including the quick launch, top
link bar, tree view, site theme, and master page. Then select the Keep look and feel
checkbox.
*Note: The Keep look and feel function will only take effect when the followings are in
place:
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o

The source node is a site, the destination node is a top-level site or a site
collection.

o

Merge is selected as the action to take in Step 1.

Click Advanced to select the configurations that you want to copy or move:
o

Site Collection Level – Site collection features and properties.

o

Site Level – Site features and properties, Site column and content type,
Navigation and quick launch, Site template and list template, Web parts, page
layout, master pages and other hidden lists.
*Note: If you have selected the Keep look and feel checkbox, you cannot
deselect the checkbox of the Site features and properties, Navigation and quick
launch, and Web parts, page layout, master pages and other hidden lists.

o

List Level – List settings and Public views.

*Note: In the Edit Copy Settings interface, the visibility of Site Collection Level, Site
Level, and List Level will change according to the selected Source node and Destination
node.


Leave the Copy/Move configuration checkbox deselected if you don’t want to migrate
the configurations to the destination. Then, choose from the following options:
o



Select Copy/Move the item-dependent columns and content types to maintain
item integrity. Selecta conflict resolution method for these items’ columns and
content types from the drop-down list:


Do not copy/move the columns and content types, or the
corresponding items – Ignores the conflicting columns, content types,
and the corresponding items, and do nothing on the source and
destination node.



Overwrite the columns and content types – Overwrites the destination
columns and content types with the source node.



Append the columns and content types to destination – Keeps the
destination columns and content types when there is a conflict. Copies
the source columns and content types to the destination node with a
numerical suffix added (for example, ColumnName_1, ColumnName_2,
etc.).

Select Do not copy/move the item-dependent columns or content types. The
corresponding item-dependent columns or content types are not copied/moved to the
destination. The job report will show items if the corresponding column or content type
is not found in the destination node.

11. Security – Select the Copy/Move security checkbox to copy/move the user and/or group
permissions from the source node to the destination node, including SharePoint permission
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level and permission inheritance of SharePoint objects. Select the Exclude user/group without
permission checkbox to not copy or move users and/or groups that have no permissions
*Note: The definition of users or groups without permission varies with the selected source
node:


If the source node is a site collection, the users or groups that meet the following two
conditions are the users or groups without permissions:
o

Users or groups that exist in the source node, but are not Site Collection
Administrators.

o

Users or groups that exist in the source node, but have no permissions to the
top-level site or any sites of the site collection.

*Note: If the source node is a Web application, the permissions of each site collection
are handled respectively, and you can refer to the definition above.


If the source node is a site, users or groups without permissions refer to the users or
groups that exist in the source node, but have no permissions to this site.



If the source node is an object whose level is lower than the site level, users or groups
without permissions refer to the users or groups that exist in the source node, but have
no permissions to the site where the source object resides.

You cannot view these types of users or groups in the People and Groups – [SiteName]
Members page of a site, but you can view them in the People and Groups – All People page. To
go to the People and Groups – All People page, modify the value of MembershipGroupId in the
URL of the People and Groups – [SiteName] Members page to MembershipGroupId=0. You will
be brought to the People and Groups – All People page.
12. Content – Select the Copy/Move content checkbox to copy/move content in libraries, folders
and items from the source node to the destination node. Select the Include list attachment to
also copy/move attached content in lists.
13. User Profile – Select the Copy/Move user profile checkbox if you want to move user profiles
from the source node to the destination node.
*Note: This section will only appear if the source node level is equal to or higher than the site
collection level because users are saved in the top-level site.
14. Workflow – Select the Include workflow definition checkbox to copy/move the definition of
existing workflows for the selected content from the source node to the destination node.
Select the Include workflow instance to copy/move the state, history and tasks of existing
workflows for the selected content from the source node to the destination node. The Include
completed instance checkbox is selected to copy the completed instance from the source node
to the destination node. You can select Include running instance checkbox if you want to copy
the currently running instance, and then select one of the following radio buttons:


Cancel workflows – Cancel the copied or moved running workflows in the destination
node after the Content Manager jobs.
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Restart workflows – Restart the copied or moved running workflows in the destination
node after the Content Manger jobs.
*Note: Content Manager does not support the workflow instances associated with
checked-out files.

15. Managed Metadata Service Setting – Select the Copy Managed Metadata Service checkbox if
you want to copy the related managed metadata services from the source node to the
destination node, and then select one of the following radio buttons:


Term – Copy terms that are used in the source, their parent terms, the term sets where
the used terms reside, and the names of the groups where the used terms reside to the
destination.



Term set – Copy the whole term sets where the used terms reside in the source
(regardless if the terms in the term sets are used by the source node or not) to the
destination.



Managed Metadata Service – Copy the whole Managed Metadata Services that are
related to the source node to the destination.

16. Preserve the Null Column Values – Select Yes to preserve the null values of item columns (such
as newly created columns), or select No to replace null values with default values in the
destination node.
17. Folder Structure Management – Choose if you want to collapse the folder structure of the
copied or moved content. Select the Collapse Folder Structure checkbox to enable this feature.
DocAve also allows you to add a column to the destination for displaying the source folder path
or parent folder name. Select the Add a column to display the source folder path or parent
folder name checkbox to enable this feature as well.


Column to display the source folder path – Enter a column name in the text box to add
a Single Line of Text column to display the source folder path.



Column to display the parent folder name – Enter a column name in the text box to add
a Single Line of Text column to display the source parent folder name.

*Note: The Folder Structure Management filed only appears when you've selected list or folder
level nodes in the source tree.
18. Data Compression – Select the Compression checkbox if you want to compress the data when it
is copied. If you choose to compress the data, use the slider to select the compression rate.
Faster compression rate result in a larger data sets. The best option is a smaller, better quality
data set, but the compression takes more time to perform.
*Note: Smaller data sets take longer to backup and recover.
19. Column Mapping – Maps source columns to the configured columns in the destination, or
change the column name to another one, according to the condition that you set up. The
specified source columns will be mapped according to the selected column type, and the
column values will be mapped according to the added value mappings. According to the column
type, the source column and the destination column can be the same or different. The column
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can also be changed to Managed Metadata or Lookup. Select a column mapping from the dropdown list, or click New Column Mapping. For information on creating a column mapping, see
the DocAve 6 Control Panel Reference Guide.
*Note: If you select the column type Change to Lookup while setting up your column mapping,
make sure that the Lookup column can only be associated with the list or list column that exists
in the destination.
20. Content Type Mapping – Replaces source content types with destination content types
according to the condition that you set up. Select a content type mapping from the drop-down
list, or click New Content Type Mapping. For information on creating a content type mapping,
see the DocAve 6 Control Panel Reference Guide.
21. Template Mapping – Replaces site and list templates. By inputting or selecting a template ID,
the source template is changed to the destination template. Select a template map from the
drop-down list, or click New Template Mapping. For information on creating a template
mapping, see the DocAve 6 Control Panel Reference Guide.
22. User Mapping – Maps a source user to a target user. If the same user has a different username
in Domain A than in Domain B, or if you want to copy or move an individual user’s content,
permissions, and metadata in Domain A to another user in Domain B, the user’s permissions and
metadata will not be lost when content is moved. Select a user mapping from the drop-down
list, or click New User Mapping. For information on creating a user mapping, see the DocAve 6
Control Panel Reference Guide.
23. Domain Mapping – Maps a source domain to a destination domain. The source domain name
will be replaced by the configured destination domain name. The user in the source domain will
be mapped to the destination user which has the same login name. Select a domain mapping
from the drop-down list, or click New Domain Mapping. For information on creating a domain
mapping, see the DocAve 6 Control Panel Reference Guide.
24. Language Mapping – Displays the destination node in a different language than source node
after the plan has been executed. Select a language mapping from the drop-down list, or click
New Language Mapping. For information on creating a language mapping, see the DocAve 6
Control Panel Reference Guide.
25. List Name Mapping – Changes the existing source lists of the copied or moved objects to your
designated lists in the destination. Select a list name mapping from the drop-down list, or click
New List Name Mapping. For information on creating a list name mapping, see the DocAve 6
Control Panel Reference Guide.
26. Conflict Resolution – Choose Skip, Merge, or Replace from the Container level conflict
resolution drop-down list. Select the Check lower objects checkbox, then choose Skip,
Overwrite, Overwrite by Last Modified Time, or Append from the Content level conflict
resolution drop-down list. For detailed information on how Content Manager resolves conflicts
based on these configurations, see Appendix A: Conflict Resolution.
27. Apps Conflict Resolution – Choose Skip, Upgrade App Only, or Replace App and AppData from
the Apps conflict resolution drop-down list. This field will only appear when the selected source
and destination nodes are in the SharePoint 2013 environments. For detailed information on
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how Content Manager resolves apps conflicts based on these configurations, see Apps Conflict
Resolution.
*Note: Apps Conflict Resolution only takes effect on the app instances.
28. Agent Group – Select a source or a destination group to execute the Content Manager job.


Source Agent Group – Select a source Agent group to back up the data in the selected
source nodes. This option only appears when the selected source nodes are in the
SharePoint on-premises environments.



Destination Agent Group – Select a destination Agent group to restore the backed up
source data to the destination node. This option only appears when the selected
destination node is in the SharePoint on-premises environment.

29. Notification – Choose the type of notification report and designate which DocAve user will
receive an email notification. Select a notification profile from the drop-down list. Click View
beside the drop-down list to view details of the notification profile, or click New Notification
Profile from the drop-down list. For information on creating a notification profile, see the
DocAve 6 Control Panel Reference Guide.
30. Associated Plan Group – Add the plan to one or more plan groups to manage plans with
common settings. Select a plan group from the drop-down list, or click New Plan Group. For
information on creating a plan group, see the DocAve 6 Control Panel Reference Guide.
31. Click Save on the ribbon, and then select Save from the drop-down list to save the plan. To save
the plan and execute it right away, click Save on the ribbon, and then select Save and Run Now
from the drop-down list.
32. At any time, click Cancel on the ribbon to abandon the new plan’s configuration and return to
the Home tab of Content Manager.

Managing Plans
Content Manager allows you to create plans so that you can repeat copy/move jobs without having to
reconfigure settings each time. When a plan is created, it will appear in Plan Manager. To access Plan
Manager, click the Plan Manager tab at the top of the DocAve interface.
You may perform any of the following actions on a selected plan:


View Details – To view detailed information of the selected plan:
o

Select the plan by selecting the corresponding checkbox, and then click View
Details on the ribbon. The View Details interface appears.

o

Click the down arrow ( ) button in the Plan Name column, and then select
View Details from the drop-down menu. The View Details interface appears
with the following options:
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Click Edit on the ribbon to make changes to the plan’s settings. The Edit
tab appears.
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Click Source & Destination on the ribbon to change the source and
destination nodes for this plan, or click Settings on the ribbon, and then
edit the plan’s settings. For more information on how to edit the plan
settings, refer to Building Plans Using Form Mode.



Click Save on the ribbon, and then select Save from the drop-down list
to save the plan. To save the plan and execute it right away, select Save
and Run Now from the drop-down list. To save a changed plan as a new
one, click Save on the ribbon, and then select Save As from the dropdown list.



Click Cancel on the ribbon at any time to return to the Plan Manager.

Edit – Edit the plan settings of the selected plan:
o

Select the plan by selecting the corresponding checkbox, and then click Edit on
the ribbon. The Edit tab appears.

o

Click the down arrow ( ) button in the Plan Name column, and then select Edit
from the drop-down menu. The Edit tab appears.


Click Source & Destination on the ribbon, and then change the source
and destination nodes for this plan, or click Settings on the ribbon, and
then edit the plan’s settings. For more information on how to edit the
plan settings, refer to Building Plans Using Form Mode.



Click Save on the ribbon, and then select Save from the drop-down list
to save the plan. To save the plan and execute it right away, click Save
on the ribbon, then select Save and Run Now from the drop-down list.
To save a changed plan as a new one, click Save on the ribbon, and then
select Save As from the drop-down list.



Click Cancel on the ribbon at any time to return to the Plan Manager.

Delete – Delete the selected plan:
o

Select the plan to delete by selecting the corresponding checkbox, and then
click Delete on the ribbon. A warning message will appear to confirm the
deletion. Click OK to delete the selected plan, or click Cancel.

o

Click the down arrow ( ) button in the Plan Name column, and then select
Delete from the drop-down menu. A warning message will appear to confirm
the deletion. Click OK to delete the selected plan, or click Cancel.



Test Run – Click Test Run on the ribbon to simulate the execution of the selected plan.
You can see the results of the test run in Job Monitor. For more information, see the
DocAve 6 Job Monitor Reference Guide.



Run Now – Click Run Now on the ribbon to execute the plan immediately. You can see
the review details about the plan’s execution in Job Monitor. For more information, see
the DocAve 6 Job Monitor Reference Guide.
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Using Data Import and Data Export
In cases where the desired source and destination nodes cannot communicate with each other (for
example, if there is a firewall), Content Manager allows you to export the content from the source node
to an Export Location, and then import it into the destination node.

Exporting Content
To export the content to an export location, click Data Export on the ribbon in the Home tab. Then
select the desired source node in the Source pane, and then click Export on the ribbon. The Destination
pane will be replaced with the Create a New Plan interface. Configure the following settings to export
content:
1. Plan Name – Enter the new Plan Name, then enter an optional description.
2. Export Location – Select an export location in Control Panel, or click New Export Location to
create a new one. For information on creating export locations, see the DocAve 6 Control Panel
Reference Guide.
3. Schedule – Configure a schedule for this plan by selecting one of the following options:


Select No Schedule to manually execute this plan.



Select Start Time to have this plan execute at a specified time. If applicable, you may
change the time zone by clicking on the hyperlink to select a different time zone.

4. Click Advanced to configure additional options.
a. Filter Policy – Select a filter policy from the drop-down list, or click New Filter Policy.
Filter policies allow you to select specific objects or data within each SharePoint level
from site collection down to the item level. For information on creating a filter policy,
see the DocAve 6 Control Panel Reference Guide.
*Note: When using the filter policy in SharePoint Online, the Created By rule is not
supported. Exceptions will be recorded in the job report.
b. Content – Select the Export content checkbox to export content in libraries, folders, and
items from the source node to the destination node. Select the Include list attachment
to also export attached content in lists.
c. User Profile – Select the Export user profile checkbox to move user profiles from the
source node to the destination node.
*Note: This section will only appear if the source node level is equal to or higher than
the site collection level because users are saved in the top-level site.
d. Data Compression – Select the Compression checkbox to compress the data when it is
exported. If you choose to compress the data, use the slider to select the compression
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rate. Faster compression rates result in larger data sets. The best compression rate is a
smaller better quality data set, but the compression takes more time to perform.
*Note: Smaller data sets take longer to backup and recover.
e. Data Encryption – Select the Encryption checkbox to encrypt the data. Then select the
Default Security Profile or a security profile from the drop-down list to protect your
backup data using the security keys generated by the specified encryption method. Or
click New Security Profile to create a new one. For details on creating a security profile,
refer to the DocAve 6 Control Panel Reference Guide. Note that encrypted data takes
longer to backup and recover.
f.

Workflow – Select the Include workflow definition checkbox to export the definition of
existing workflows for the selected content from the source node to the destination
node. Select the Include workflow instance checkbox to also export the state, history,
and tasks of existing workflows for the selected content from the source node to the
destination node.
*Note: Content Manager does not support the workflow instances associated with
checked-out files.

g. Managed Metadata Service Setting – Select the Copy Managed Metadata Service
checkbox if you want to copy the related managed metadata services from the source
node to the destination node, and then select one of the following radio buttons:
o

Term – Copy terms that are used in the source, their parent terms, the term sets
where the used terms reside, and the names of the groups where the used
terms reside to the destination.

o

Term set – Copy the whole term sets where the used terms reside in the source
(regardless if the terms in the term sets are used by the source node or not) to
the destination.

o

Managed Metadata Service – Copy the whole Managed Metadata Services that
are related to the source node to the destination.

h. Generate Metadata File ‒ Select the Generate Metadata File checkbox to generate
Microsoft Excel files with metadata for each library or list. The metadata files are stored
in the export location you configured. You can edit the metadata file to add, edit, or
delete the metadata of items in batch.
i.

Agent Group – Select an Agent group to execute the export job. This option only
appears when the selected source nodes are in the SharePoint on-premises
environments.

j.

Notification – Choose the type of notification report and designate which DocAve user
will receive an email notification. Select a notification profile from the drop-down list.
Click View beside the drop-down list to view details of the notification profile or click
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New Notification Profile. For information on creating a notification profile, refer to the
DocAve 6 Control Panel Reference Guide.
k. Associated Plan Group – Add the plan to one or more plan groups to manage plans with
common settings. Select a plan group from the drop-down list or click New Plan Group
from the drop-down list to create a new one. For information on creating a plan group,
refer to the DocAve 6 Control Panel Reference Guide.
5. Click Save to save the export plan. To save the export plan and execute it right away, click Save,
and then select Save and Run Now.
6. Click Cancel at any time to abandon the new export plan’s configuration and return to the Home
tab of Content Manager.

Importing Content
To import content from an export location, click Data Import on the ribbon in the Home tab. Then select
the desired destination node in the Destination pane. The Source pane will be replaced with the Import
configuration interface. To import content, configure the following settings:
1. Plan Name – Enter the new Plan Name, then enter an optional description.
2. Browse – In the Browse tab, click on the export location to expand its data tree. Select the
exported content. Click the Details tab to see what content is included.
3. Action – Select Attach to transfer the source node as a child node underneath the destination
node, or select Merge to add the content, securities, and configurations of the source node to
the destination node. To see what the data tree of the destination node will look like after the
job is executed, click Show Preview.
4. Schedule – Configure a schedule for this plan by choosing one of the following options:


Select No Schedule to manually execute this plan.



Select Start Time to have this plan execute at a specified time. If applicable, you may
change the time zone by clicking on the hyperlink to select a different time zone.

5. Click Advanced to configure further options.
a. Conflict Resolution – Choose Skip, Merge, or Replace from the Container level conflict
resolution drop-down list. Select the Check lower objects checkbox if you want to
configure content level conflict resolution, then choose Skip, Overwrite, Overwrite by
Last Modified Time, or Append from the Content level conflict resolution drop-down
list. For detailed information on how Content Manager resolves conflicts based on these
configurations, see Appendix A: Conflict Resolution.
b. Configuration – If you want to import the properties, descriptions, titles, settings, and
features from the source node to the destination node, select the Import configuration
checkbox. If you do not want to import the configurations, leave the checkbox
deselected, and configure the following options:
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o

o

Select the Import the item-dependent columns and content types to maintain
item integrity radio button to import the item dependent columns and content
types to destination and choose one of the following options from the Conflict
resolution for dependent items drop-down list:


Do not copy/move the columns and content types, or the
corresponding items – Ignores the conflicting columns, content types,
and the corresponding items and do nothing on the source and
destination node.



Overwrite the columns and content types – Overwrites the destination
columns and content types with that of the source node.



Append the columns and content types to destination – Keeps the
destination columns and content types when there is a conflict. In
addition, copy the source columns and content types to the destination
node with a numerical suffix added (for example, ColumnName1,
ColumnName2, etc.).

Select the Do not Import the item-dependent columns or content types radio
button to not import item dependent columns or content types. The
corresponding items will not be imported to the destination. DocAve will report
the items if the corresponding column or content type is not found in the
destination node.

c. Security – Select the Import security checkbox to import the user and/or group
permissions from the source node to the destination node, including SharePoint
permission level and permission inheritance of SharePoint objects. Select the Exclude
user/group without permission checkbox to not import users and/or groups that have
no permissions.
*Note: The definition of users or groups without permission varies with the selected
source node:
o

If the source node is a site collection, the users or groups that meet the
following two conditions are the users or groups without permissions:


Users or groups that exist in the source node, but are not Site Collection
Administrators.



Users or groups that exist in the source node, but have no permissions
to the top-level site or any sites of the site collection.

*Note: If the source node is a Web application, the permissions of each site
collection are handled individually, and you can refer to the definition above.
o

If the source node is a site, users or groups without permissions refer to the
users or groups that exist in the source node, but have no permissions to this
site.
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o

If the source node is an object whose level is lower than the site level, users or
groups without permissions refer to the users or groups that exist in the source
node, but have no permissions to the site where the source object resides.

You cannot view these types of users or groups in the People and Groups – [SiteName]
Members page of a site, but you can view them in the People and Groups – All People
page. To go to the People and Groups – All People page, modify the value of
MembershipGroupId in the URL of the People and Groups – [SiteName] Members page
to MembershipGroupId=0. You will be brought to the People and Groups – All People
page.
d. Managed Metadata Service Setting – Select the Copy Managed Metadata Service
checkbox if you want to copy the related managed metadata services from the source
node to the destination node. Select Term set to copy the whole term sets where the
used terms reside in the source (regardless if the terms in the term sets are used by the
source node or not) to the destination.
e. Preserve the Null Column Values – Select Yes to preserve the null values of item
columns, or select No to replace null values with default values in the destination node.
f.

Folder Structure Management – Choose whether or not to collapse the folder structure
of the copied or moved content. Select the Collapse Folder Structure checkbox to
enable this feature. DocAve also allows you to add a column to the destination for
displaying the source folder path or parent folder name of the source folder. Select the
Add a column to display the source folder path or parent folder name checkbox to
enable this feature as well.
o

Column to display the source folder path – Enter a column name in the text box
to add a Single Line of Text column to display the source folder path.

o

Column to display the parent folder name – Enter a column name in the text
box to add a Single Line of Text column to display the source parent folder
name.

*Note: The Folder Structure Management field only appears when the source nodes of
the exported data you selected are the list or folder level ones.
g. Column Mapping – Maps source columns to destination columns by using a customized
column mapping or an existing metadata file which is generated in Export Location.
Choose Use Column Mapping and select a column mapping from the drop-down list, or
click New Column Mapping from the drop-down list. For information on creating a
column mapping, refer to the DocAve 6 Control Panel Reference Guide. To apply an
existing metadata file in the Export Location to this import job, choose Use existing
metadata file.
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*Note: If you choose to change a column to a Lookup column, make sure that the
Lookup column can only be associated with the list or list column that exists in the
destination.
h. Content Type Mapping – Maps source content types to entered content types in the
destination, or change the content type name to another one. Select a content type
mapping from the drop-down list, or click New Content Type Mapping. For information
on creating a content type mapping, refer to the DocAve 6 Control Panel Reference
Guide.
i.

Template Mapping – Replaces site templates and list templates. By inputting or
selecting a template ID, the source template is changed to the destination template.
Select a template mapping from the drop-down list, or click New Template Mapping.
For information on creating a template mapping, see the DocAve 6 Control Panel
Reference Guide.

j.

User Mapping – Maps a source user to a target user. If the same user has a different
username in Domain A than in Domain B, or if you want to move an individual user’s
content, permissions, and metadata in Domain A to another user in Domain B, the
user’s permissions and metadata will not be lost when the content is moved. Select a
user mapping from the drop-down list, or click New User Mapping. For information on
creating a user mapping, see the DocAve 6 Control Panel Reference Guide.

k. Domain Mapping – Maps a source domain to a destination domain. The source domain
name will be replaced by the configured destination domain name, and the user in the
source domain will be mapped to the destination user which has the same login name.
Select a domain mapping from the drop-down list, or click New Domain Mapping. For
information on creating a domain mapping, see the DocAve 6 Control Panel Reference
Guide.
l.

Language Mapping – Displays the destination node in a different language than the
source node after the plan has been executed. Select a language mapping from the
drop-down list, or click New Language Mapping f. For information on creating a
language mapping, see the DocAve 6 Control Panel Reference Guide.

m. List Name Mapping – Changes the existing source lists of the copied or moved objects
to your designated lists in the destination. Select a list name mapping from the dropdown list, or click New List Name Mapping. For information on creating a list name
mapping, see the DocAve 6 Control Panel Reference Guide.
n. Backup Environment Before Running Plan – Select the Backup the destination
environment checkbox to create a copy of the destination node prior to performing the
copy). If you choose this option, you must designate a storage policy. Select a storage
policy or click New Storage Policy to create a new one.
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*Note: Content Manager only supports the Backup type storage policy. For more
information on storage policies, see the DocAve 6 Control Panel Reference Guide.
o. Agent Group – Select an Agent group to execute the import job. This option only
appears when the selected destination node is in the SharePoint on-premises
environments.
p. Notification – Choose the type of notification report and designate which DocAve user
will receive an email notification. Select a notification profile from the drop-down list.
Click View beside the drop-down list to view details of the notification profile or click
New Notification Profile. For more information on creating a notification profile, see
the DocAve 6 Control Panel Reference Guide.
q. Associated Plan Group – Add the plan to one or more plan groups to manage plans with
common settings. Select a plan group from the drop-down list or click New Plan Group.
For information on creating a plan group, see the DocAve 6 Control Panel Reference
Guide.
6. Click Save to save the export plan. To save the export plan and execute it right away, click Save,
and then select Save and Run Now.
7. Click Cancel at any time to return to the Home tab of Content Manager.
*Note: Exported Content Manager data can only be imported into SharePoint through the same version
of DocAve that was used to export the data.

Editing Metadata File
You can edit the metadata file to add, edit, or delete metadata in batch. To edit the metadata file,
complete the following steps:
1. Open the folder Content Manager 2010 in the Export Location, and then open the folder named
by Job ID with a _001 suffix.
2. Inside that folder, open the subfolder that is named by GUID to see a list of Microsoft Excel files.
Each library or list generates an Excel file. Columns, items, and their corresponding column
values of a library or list are displayed in the Excel file.
3. You can add, edit, and delete the metadata file in the Excel file.
*Note: The column Content Type: = Computed and the corresponding value cannot be edited.


Add the metadata. Add a column, specify its column type, and set a value for the item in
the Excel file. The newly added column will be imported to the destination view.
For example, add a new column next to the existing column on the first row, enter
Comments: = Multiple lines of text and set the value of an item as It needs to be
updated. Here Comments is the column name, Multiple lines of text is the column type,
and It needs to be updated is the corresponding value for the item. After the import
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job, the column will be added to the destination default view and the column
Comments and the value will also be added as new metadata for the item.


Edit the metadata. Edit the column name and column type of an item, and modify the
corresponding value in the Excel file.
For example, in the Excel file, the column name, column type of an item is Name: = File
and the corresponding value is Document A. You can modify the item name by
modifying the value Document A to Document B. After the import job, the item name
will be displayed as Document B in the destination.



Delete the metadata. Delete the column name, column type of an item, and the
corresponding value in the Excel file.
For example, in the Excel file, the column name and column type of an item is Title: =
Single line of text and the corresponding value is Custom List. If you do not want this
column title or type and the value for this item to be associated with the item in the
destination after being imported, delete the column name, column type, and the
corresponding value from the cells.
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Advanced Settings
Content Manager offers these additional settings that can be applied to Content Manager plans:


Mappings – The available mappings for Content Manager plan are:
o

List Name Mapping allows you to change the existing source lists of the copied
or moved objects to your designated lists in the destination. Select a list name
mapping from the drop-down list, or click New List Name Mapping.

o

Column Mapping is used to replace source columns with destination columns.
According to column type, the source and destination column type can be the
same or different. The column can be changed to Managed Metadata or
Lookup.

o

Content Type Mapping allows you to replace the source content types with the
destination content type according to the condition that you set up.

o

Template Mapping helps you achieve replacing site template and list template.
By inputting or selecting a template ID, the source template is changed to the
destination template.

o

User Mapping is beneficial for migrating groups of users from one domain to
another and for migrating an individual user’s content and permissions to
another user.

o

Domain mapping is used to replace a source domain name with a domain name
in the destination. The user in the source group will be mapped to the
destination user with the same name.

o

Language Mapping allows you to set a different language for the destination
than the language used in the source. By creating a language mapping rule, any
plans using the rule can repeat the process without having to manually reenter
the settings.



Export Location allows you to configure locations on external system storage where you
want Content Manager to export the data. By configuring an external system storage,
you can also export design elements to the file system. This feature is useful in cases
where two farms are unable to communicate with each other. You can use export
locations to perform offline deployments to deploy from an external device.



Storage Policy allows you to specify which logical device to use when storing content or
when performing imports and exports for offline deployment.
*Note: Content Manager only supports the Backup type storage policy.
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Filter Policy allows you to set up filter rules so you can control what objects and data
within any SharePoint level appear so that you can target content to migrate more
precisely. By setting up and saving filter policies, you can apply the same filter policies to
different plans without having to recreate them each time.
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Content Manager for SharePoint Online
Content Manager allows you to copy/move content from Microsoft SharePoint 2010/SharePoint 2013 to
SharePoint Online. To perform this function properly, you must configure your SharePoint sites in
Control Panel. For more detailed information about this configuration, see the Registered SharePoint
Sites section in the DocAve 6 Control Panel Reference Guide.
Before using Content Manager for SharePoint Online, make sure you have purchased the corresponding
Content Manager for SharePoint Online licenses.
For details about how to perform a simple copy, run a simple move, perform a data export, perform a
data import, or build a plan, refer to Copying Content, Moving Content, Exporting Content, Importing
Content, and Building Plans.
Certain settings are different when the destination node is in a SharePoint Online environment. To
review supported settings for SharePoint Online, refer to Appendix C: Supported and Unsupported
Content Manager Settings for SharePoint Online.
Content Manager for SharePoint Online only supports the Create Container function for site, list, and
folder levels in a SharePoint Online destination node.
If given the corresponding permissions, users in the Tenant groups can view and modify a DocAve plan,
profile, or job created by the other users that are also in this group. For detailed information on the
permission control of the users in the Tenant groups, refer to the DocAve 6 Control Panel Reference
Guide.
When selecting the source node and the destination node to perform a Content Manager job, make sure
that the source node and the destination node are in the same version of SharePoint. However, the
Content Manager for SharePoint Online supports to copy or move the contents from a SharePoint 2013
site with SharePoint 2010 experience version to a SharePoint 2013 site. For more information, refer to
the Appendix H: The Supported and Unsupported Methods to Copy or Move Sites of Different
SharePoint Experience Versions.
Content Manager for SharePoint Online supports copying or moving the Apps for SharePoint. However,
there are some limitations for the apps that are not added from the SharePoint App Store:


Because of the Client API limitation, DocAve cannot obtain the app stream stored in the
Microsoft server database. Therefore, DocAve cannot automatically create an app
definition in the destination App Catalog Site Collection.
o

When backing up the app definition, DocAve cannot back up all of the app
definition's installation components. Instead, DocAve obtains and backs up
some properties, such as the Product ID, and Product Version.
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o



An app definition that is the same as the source must exist in the destination
App Catalog Site Collection so DocAve can restore the source app and AppData
normally.

Make sure that the user used to register all of the site collections under the My
Registered Sites node in the tree has Read, or above permission to the Apps for
SharePoint library in the App Catalog Site Collection. Otherwise, DocAve cannot load
the Apps node in the tree.

You can use the DocAve Agent that cannot connect to the internet to run a Content Manager job using
SharePoint Online nodes. To do so, you must configure the Agent Proxy Settings in Control Panel. For
more information, refer to the DocAve 6 Control Panel Reference Guide.
Content Manager for SharePoint Online supports copying or moving the SharePoint 2013 Workflow
platform. However, only the list level and site level workflows are currently supported.
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Appendix A: Conflict Resolution
Container Level Conflict Resolution
Resolution
Skip

Object
Configuration

Security

Merge

Configuration

Security

Replace

Configuration

Security
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Conflict
Ignore the conflicting configuration and
do nothing on the source and
destination.
Ignore the conflicting security and do
nothing on the source and destination.
Overwrite the settings in the
destination node with settings from the
source node.
 Source permissions that do not
already exist in the destination
node will be added to the
destination node.
 Permission levels from the source
node will replace those in the
destination node.
 Site collection level, site level, or
folder level – Content,
configurations, and securities of the
destination node will be replaced
with those in the source node.
 Root site level, list/library level, or
root folder level – All objects under
the conflicting container will be
deleted and replaced with source
content, and configurations. The
securities under the conflicting
container will be merged to the
destination.
*Note: Root site level and sub-site
level are regarded as the same
level. That is, if the conflict exists at
the root site level, the sub-site will
not be deleted.
Conflicting securities on the destination
node will be overwritten with that of
the source node.

No Conflict
A new SharePoint
object will be
created.
A new SharePoint
object will be
created.
A new SharePoint
object will be
created.
A new SharePoint
object will be
created.

A new SharePoint
object will be
created.

A new SharePoint
object will be
created.
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Content Level Conflict Resolution
Resolution
Skip

Object
Content

Conflict
Ignore the conflicting content and do
nothing on source and destination.

Overwrite

Content

Overwrite by
Last Modified
Time

Content

Delete the conflicting content on
destination first and overwrite it with
the source content.
If the last modified time of source
conflicting content is later than that of
destination one, it will overwrite the
destination content by source one;
otherwise, do nothing on the source
and destination node.

Append

Content

The conflicting content will not be
deleted; the conflicting document will
be transferred to the destination by
adding a suffix to the document name
(_1, _2, …, increasing in numerical
value), and the conflicting item will be
transferred to the destination by
adding 1 to the item ID.

No Conflict
A new SharePoint
object will be
created.
A new SharePoint
object will be
created.
A new SharePoint
object will be
created.

A new SharePoint
object will be
created.

Apps Conflict Resolution
Resolution
Skip

Object
App

AppData

Update App Only

App

AppData
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Conflict
Ignore the conflicting
app instance and do
nothing on source and
destination.
Ignore the conflicting
AppData and do
nothing on source and
destination.
The latest version app
instance will be kept in
the destination.
Ignore the conflicting
AppData and do
nothing on source and
destination.
*Note: This will cause
the version of the app

No Conflict
The source app
instance is created in
the destination.
The source AppData is
created in the
destination.
The source app
instance is created in
the destination.
The source AppData is
created in the
destination.
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Resolution

Object

Replace App and
AppData

App

AppData
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Conflict
and that of the
AppData to not be the
same version in the
destination after the
Content Manager job.
The app may not work
well.
The destination app
instance is deleted
while the source app is
created in the
destination.
The destination
AppData is deleted
while the source
AppData is created in
the destination.

No Conflict

The source app
instance is created in
the destination.

The source AppData is
created in the
destination.
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Appendix B: Supported Online and Offline Content Manager Settings for
SharePoint On-Premises
Refer to the following sections for more information.

Supported Online Content Manager Settings
The following table identifies the supported settings for copy and move jobs using SharePoint on-premises nodes.
*Note: The options that only exist for moves have been marked as (Move Only). The options that only exist for Merge have been marked as
(Merge Only).
Supported Online Settings
Attach
Merge
Preview
Promote top-level site to site collection
Promote Method (Merge
Only)
Promote all sites to site collections
Which managed path would you like to use in the destination? (Merge Only)
Filter Policy
Action

Copy/Move configuration
Select Source
Components

Configuration

Deselect Copy/Move configuration
Copy/Move the item dependent
columns and content types to
maintain item integrity
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Keep look and feel
Advanced:
Site Collection Level
Site Level
List Level
Do not copy/move the columns and content types, or the
corresponding items
Overwrite the columns and content types
Append the columns and content types to destination
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Supported Online Settings
Do not copy/move the item dependent columns or content types. Report the items if the
corresponding column or content type is not found in destination.
Exclude user/group without permission
Include list attachment

Security
Content
User Profile
Include workflow definition
Workflow

Managed Metadata
Service Setting

Include completed instance
Include workflow instance

Include running instance

Cancel workflows
Restart workflows

Term
Term set
Managed Metadata Service

Copy Managed Metadata Service

No schedule
Configure the schedule myself
Preserve the Null Column Values
Schedule

Folder Structure
Management

Collapse Folder Structure

Add a column to display the source
folder path or parent folder name

Column to display the source folder
path
Column to display the parent folder
name

Data Compression
Column Mapping
Content Type Mapping
Template Mapping
Domain Mapping
User Mapping
Language Mapping
List Name Mapping
Manual
Automatic
Delete Source Checked Out Documents (Move Only)
Backup the source environment (Move Only)
Backup Environment Before Running
Plan
Backup the destination environment
Source Deletion Method (Move Only)
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Conflict Resolution

Apps Conflict Resolution
Agent Group

Supported Online Settings
Skip
Container level conflict
Merge
resolution
Replace
Check lower objects
Skip
Overwrite
Content level conflict
resolution
Overwrite by Last Modified Time
Append
Skip
Update App Only
Replace App and AppData
Source Agent Group
Destination Agent Group

Notification
Associated Plan Group

Supported Offline Content Manager Settings
The following table identifies the supported settings for copy jobs performed for Data Export and Data Import.

Export Settings
Refer to the following table for more information.
Export Settings
Filter Policy
Select Source Components

Content
User Profile

Include list attachment

Data Compression
Data Encryption
Workflow
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Include workflow definition
Include workflow instance

Support Status
Supported
Supported
Supported
Supported
Supported
Supported

Comment

Supported
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Managed Metadata Service Setting

Export Settings
Term
Term set
Managed Metadata Service

Generate Metadata File
Agent Group
Notification
Associated Plan Group

Support Status
Supported
Supported
Supported
Supported
Supported
Supported
Supported

Comment

Import Settings
Refer to the following table for more information.
Import Settings
Action

Attach
Merge
Preview
Container level conflict
resolution

Conflict
Resolution

Skip
Merge
Replace

Check lower objects
Content level conflict
resolution

Skip
Overwrite
Overwrite by Last Modified Time
Append

Skip
Apps Conflict
Resolution

Update App Only
Replace App and AppData
Configuration
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Import configuration

Support Status
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Partially
Supported
Partially
Supported
Partially
Supported
Supported

Comment

Unsupported for
SharePoint 2010
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Import Settings

Deselect Import
configuration

Select Source
Components

Security

Import security

Import the
itemdependent
columns and
content types
to maintain
item integrity
Conflict
resolution for
dependent
items:

Do not copy/move
the columns and
content types, or
the corresponding
items

Overwrite the
columns and
content types
Append the
columns and
content types to
destination
Do not import the item-dependent
columns or content types. Report the
items if the corresponding column or
content type is not found in
destination

Supported

Exclude user/group without
permission

Supported

Include workflow definition
Workflow

Managed
Metadata Service
Setting

Include workflow instance

Preserve the Null Column Values
Folder Structure Management
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Include completed instance
Include
Cancel the workflow
running
Restart the workflow
instance
Term

Copy Managed Metadata Service

Support Status
Supported

Comment

Supported

Supported

Supported
Supported
Supported
Supported

Term set

Supported
Supported

Managed Metadata Service

Supported
Supported
Supported
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Import Settings
Using Column Mapping
Use existing metadata file
Content Type Mapping
Template Mapping
Domain Mapping
User Mapping
Language Mapping
List Name Mapping
Backup
Environment
Backup the destination environment
Before Running
Plan
Agent Group
Notification
Associated Plan Group
Column Mapping
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Support Status
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported

Comment

Supported
Supported
Supported
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Appendix C: Supported and Unsupported Content Manager Settings for
SharePoint Online
Refer to the following sections for more information.

Supported Online Content Manager Settings
The following table identifies the supported and unsupported Content Manager settings for SharePoint Online environments for copy and move
jobs.
*Note: Options that only exist in Move have been marked as (Move Only).
Functionality Name

Action

Support
Status
Supported
Supported
Supported
Supported

Attach
Merge
Preview
Manual

Source Deletion
Method (Move
Automatic
Only)
Delete Source Checked Out Documents (Move Only)
Filter Policy
Copy/Move
configuration
Select Source
Components

Configuration
Deselect Copy/Move
configuration
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Comment

Supported

Keep look and feel
Advanced:
Site Collection Level
Site Level
List Level
Do not copy/move the
columns and content types,
or the corresponding items

Supported
Supported
Supported
Supported

Partially
Supported

This setting is not supported
when the source content type
does not have parent content
type.
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Functionality Name
Copy/Move the itemdependent columns
and content types to
maintain item integrity

Security
Content
User Profile
No schedule
Start time
Schedule

Workflow

Support
Status
Overwrite the columns and
content types

Supported

Append the columns and
content types to
destination

Partially
Supported

Do not copy/move the item-dependent columns or
content types. Report the items if the corresponding
column or content type is not found in destination.

Supported

Copy/Move security

Supported

Exclude user/group without permission

Partially
Supported

Include list attachment

Configure the schedule myself (Move
Only)

Start time
Interval: __Days
No end date

Supported
Supported
Supported
Supported
Supported
Supported
Supported

End after__occurrences

Supported

End by__

Supported
Supported
Unsupported
Unsupported
Unsupported
Partially
Supported

Include workflow definition
Include completed instance
Include
workflow
Cancel workflows
Include running
instance
instance
Restart workflows
Term
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Comment

This setting is not supported
when the source content type
does not have parent content
type.

This setting is not supported
when the source node is from
My Registered Sites.
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Functionality Name
Managed
Metadata
Service Setting

Copy Managed
Metadata
Service

Term set
Managed Metadata Service

Preserve the Null Column Values
Folder Structure Management
Data Compression
Column Mapping
Content Type Mapping
Template Mapping
Normal User Mapping
Add a default destination user
User Mapping
Add a place holder account to keep metadata even if the user no longer
exists
Domain Mapping
Language Mapping
List Name Mapping
Backup the source environment (Move Only)
Backup the destination environment
Backup
Environment
Before Running
Rollback
Plan
Skip
Merge
Replace
Check lower objects
Skip
Content Level
Overwrite
Overwrite by Last Modified Time
Container Level
Conflict
Resolution
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Support
Status
Partially
Supported
Partially
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported

Comment
Unsupported when the source
and destination nodes are
from SharePoint 2010.

Unsupported
Supported
Supported
Supported
Supported
Supported
Partially
Supported

For the site collection node,
Content Manager will empty
the site collection instead of
deleting it when rolling back in
the Replace way.

Supported
Supported
Supported
Supported
Supported
Supported
Supported
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Functionality Name

Notification
Associated Plan Group

Support
Status
Unsupported
Partially
Supported
Partially
Supported
Partially
Supported
Supported
Supported

Create Container

Partially
Supported

Append
Skip
Apps Conflict
Resolution

Update App Only
Replace App and AppData

Comment

Unsupported when running a
Content Manager job from the
SharePoint Online node to a
SharePoint on-premises node.

Unsupported for site
collection.

Supported Offline Content Manager Settings
The following table identifies the supported settings for copy jobs performed for Data Export and Data Import.

Export Settings
Refer to the following table for more information.
Export Settings
Filter Policy
Select Source Components

Content
User Profile

Data Compression
Data Encryption
Workflow
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Include workflow definition
Include workflow instance

Include list attachment

Support Status
Supported
Supported
Supported
Supported
Supported
Supported
Unsupported

Comment
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Export Settings
Term
Managed Metadata Service Setting

Term set
Managed Metadata Service

Generate Metadata File
Notification
Associated Plan Group

Support Status
Partially
Supported
Partially
Supported
Partially
Supported
Supported
Supported
Supported

Comment
Unsupported when
the source and
destination nodes
are from
SharePoint 2010.

Import Settings
Refer to the following table for more information.

Action

Conflict
Resolution

Apps
Conflict
Resolution
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Import Settings
Attach
Merge
Preview
Skip
Container level
conflict
Merge
resolution
Replace
Check lower objects
Skip
Content level
Overwrite
conflict
Overwrite by Last Modified Time
resolution
Append
Skip
Update App Only
Replace App and AppData
Configuration Import configuration

Support Status
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Unsupported
Partially Supported
Partially Supported
Partially Supported

Comment

Unsupported for
SharePoint 2010

Supported
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Import Settings
Import the
itemdependent Do not copy/move the columns and
content types, or the corresponding
columns
items
and
content
types to
Overwrite the columns and content
maintain
types
item
Deselect
integrity
Import
configuration Conflict
resolution Append the columns and content
types to destination
for
dependent
items:
Do not import the item-dependent columns or
content types. Report the items if the
corresponding column or content type is not
found in destination

Select
Source
Components

Support Status
Partially Supported

Supported
Partially Supported

Workflow

Managed
Metadata
Service
Setting

Import
security

Exclude user/group without permission

Include workflow definition
Include completed instance
Include workflow
Include
Cancel the workflow
instance
running
Restart the workflow
instance
Term
Copy Managed Metadata
Term set
Service
Managed Metadata Service
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Do not support
this setting when
the source content
type does not have
parent content
type.

Supported

Partially Supported
Security

Comment
Do not support
this setting when
the source content
type does not have
parent content
type.

Do not support
this setting when
the source node is
from My
Registered Sites.

Supported
Unsupported
Unsupported
Unsupported
Partially Supported
Partially Supported

Unsupported when
the source and
destination nodes

Partially Supported
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Import Settings

Preserve the Null Column Values
Folder Structure Management
Using Column Mapping
Column
Mapping
Use existing metadata file
Content Type Mapping
Template Mapping
Domain Mapping
User Mapping

Support Status

Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Partially Supported

Language Mapping
List Name Mapping
Backup
Environment
Before
Backup the destination environment
Running
Plan
Notification
Associated Plan Group
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Comment
are from
SharePoint 2010.

Keeping user's
metadata is not
supported for
SharePoint Online.

Supported
Supported

Supported
Supported
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Appendix D: Supported and Unsupported Elements for Content Manager
The following table lists the currently supported and unsupported elements for Content Manager.
Source
Libraries

Communications List

Tracking Lists

Custom Lists

Web Pages
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Type
Document Library
Form Library
Wiki Page Library
Picture Library
Translation Management Library
Data Connection Library
Slide Library
Report Library
Asset Library
DocAve Content Library
DocAve Media Library
Announcements
Contacts
Discussion Board
Links
Calendar
Tasks
Project Tasks
Issue Tracking
Survey
Custom List
Custom List in Datasheet View
Language and Translators
KPI Lists (in SharePoint 2010)
Status Lists (in SharePoint 2013)
Import Spreadsheet
Basic Page
Web Part Page

Status
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported

Comment

81

Source
Workflow
*Note: Content Manager does not
support the workflow instances
associated with the checked-out files.
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Type
sites and Workspaces
SharePoint 2010 Workflow Platform

Status
Supported
Partially Supported

Comment

SharePoint 2013 Workflow Platform

Partially Supported

SharePoint Designer 2010 Workflow

Partially Supported

SharePoint Designer 2013 Workflow

Partially Supported

Support both
workflow definition
and instance for
SharePoint onpremises. Only
support workflow
definition for
SharePoint Online.
Support both
workflow definition
and instance for
SharePoint onpremises. Only
support workflow
definition for
SharePoint Online.
For SharePoint
Designer 2010
Workflow: Support
both workflow
definition and
instance for

Support both
workflow definition
and instance for
SharePoint onpremises. Only
support the
workflow definition
for SharePoint
Online.
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Source

Type

Status

Comment
SharePoint onpremises. Only
support workflow
definition for
SharePoint Online.
For SharePoint
Designer 2013
Workflow: Support
the workflow
definition for both
SharePoint onpremises and
SharePoint Online.

Nintex 2010 Workflow

Partially Supported

Unsupported for
SharePoint Online.

Nintex 2013 Workflow

Partially Supported

Unsupported for
SharePoint Online.

Visual Studio 2010 Workflow
Visual Studio 2012 Workflow
Visio Workflow
Azure Workflow

Unsupported
Unsupported
Unsupported
Unsupported
Supported
Partially Supported

RSS
Alerts

Metadata
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Single line of text
Multiple lines of text
Choice (menu to choose from)
Number

Unsupported when
the source nodes are
from My Registered
Sites.

Supported
Supported
Supported
Supported
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Source

Security & Properties

Version Histories
Apps for SharePoint

User Profile

Type
Currency
Date and Time
Look up
Yes/No
Person or Group
Hyperlink or Picture
Calculated
Business Data
Managed Metadata

Status
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Partially Supported

Version Settings
Column Settings
Permissions
Documents
Lists
SharePoint-hosted Apps
Provider-hosted Apps

Supported
Supported
Supported
Supported
Supported
Supported
Supported

Auto-hosted Apps

Supported

Colleagues

Back up

Supported

Membership

Restore
Back up

Supported
Partially Supported

Restore

Partially Supported

Back up

Partially Supported

Restore

Partially Supported

Organization
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Comment

Unsupported for the
SharePoint 2010 onpremises node from
My Registered Sites.

Unsupported for
SharePoint Online
Unsupported for
SharePoint Online
Unsupported for
SharePoint Online
Unsupported for
SharePoint Online
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Source

Type
Tags/Comments Back up

Status
Partially Supported

Restore
Back up

Unsupported
Partially Supported

Restore

Partially Supported

Other basic
properties

Back up
Restore

Supported
Partially Supported

Customized
properties

Back up

Partially Supported

Restore

Partially Supported

Quick Links

Site

Create User Profile

Partially Supported

Blog Site

Supported

Comment
Unsupported for
SharePoint Online
Unsupported for
SharePoint Online
Unsupported for
SharePoint Online
For SharePoint
Online sites,
properties can only
be restored when
Allow User to edit
values for this
property is set to
Yes.
Unsupported for
SharePoint Online
Unsupported for
SharePoint Online
Unsupported for
SharePoint Online

*Note: By default, Content Manager does not support copying or moving the Metadata Navigation setting of the SharePoint 2013 site
collections. However, Content Manager supports it after modifying the Content Manager configuration file. To modify the Content Manager
configuration file, complete the following steps:
1. Log into the server where DocAve Agent resides.
2. Go to the ...\AvePoint\DocAve6\Agent\data\SP2010\ContentManager directory.
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3. Open the SP2010CMConfiguration.xml file using Notepad.
4. Locate the <RestoreMetadataNavigation value="false"/> node.
5. Change its value to true.
6. Save the changes and close the file.
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Appendix E: Supported and Unsupported SharePoint 2013 Social Features
Social Feature
My Site

Status
Partially Supported

SkyDrive Pro (or named OneDrive for Business)
Blog
Tag

Supported
Supported
Partially Supported

Microblog and Feed

Partially Supported
Partially Supported
Partially Supported
Partially Supported
Partially Supported
Partially Supported
Partially Supported
Partially Supported
Supported
Partially Supported
Partially Supported
Unsupported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported

Follow

Community Site
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Post
Reply
Like
Picture
Link
@
Mentions
Tag
People
Site
Document
Tag
Categories
Discussion Board
Members
Budge
Reputation
Best Reply
Question
Community Setting

Note
The head portraits of the users are
not supported.

The #Tag is stored in Managed
Metadata Service as System Term.
Unsupported for SharePoint Online
Unsupported for SharePoint Online

Unsupported for SharePoint Online
Unsupported for SharePoint Online
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Social Feature
Community Portal
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Status
Supported

Note
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Appendix F: Accessing Hot Key Mode
In order to work faster and improve your productivity, DocAve supports hot key mode for you to perform corresponding actions quickly by only
using your keyboard. To access hot key mode from the Content Manager interface, press the key combination of Ctrl +Alt + Z (simultaneously)
on your keyboard.
The following table provides a list of hot keys for the top level. Each time you want to go back to the top level after accessing the interface of
lower level, press on the keyboard. For example, continue pressing H to jump to Content Manager Home Page.
Operation Interface
Content Manager Home Page
Content Manager Plan Manager
DocAve Home Page
DocAve Online Community
Control Panel
Job Monitor
Plan Group
Health Analyzer
Account Information
Help and About

Hot Key
H
P
1
2
3
4
5
6
9
0

Home Page
To access the Home page by using hot keys in the Content Manager interface, press the Ctrl + Alt + Z key combination to access the hot key
mode, and then press H on the keyboard to enter the Home page.
The following table is a list of hot keys for the functionalities on the ribbon of the Home page. For example, continue pressing O to jump to the
Data Export interface.

Online Content Manager
Copy
Move
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Functionality Name and Hot Key
L
C
M
89

Data Export
Data Import
Create Container
Plan Builder
Export Location
Storage Policy
Filter Policy

Mappings

A

Job Monitor

J

Functionality Name and Hot Key
O
I
N
P
E
S
F
Column Mapping
CL
Content Type Mapping
CT
Template Mapping
T
User Mapping
U
Domain Mapping
D
Language Mapping
LM
List Name Mapping
LN

Copy

Copy

C

Default Copy Settings

D
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Functionality Name and Hot Key
View
Edit
Preview
Run Now
Cancel
Save
Cancel

V
E
P
R
C
S
C
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Move

Move

M

Default Move Settings

D

Functionality Name and Hot Key
View
Edit
Preview
Run Now
Cancel
Save
Cancel

V
E
P
R
C
S
C

Plan Builder
Functionality Name and Hot Key
Back
B
Next
N
Wizard Mode

Form Mode
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W

F

Finish

F

Cancel

C

Save

S

Cancel

C

Finish and Run Now
Finish

R
F

Save and Run
Save

R
S
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Plan Manager Page
To access the Plan Manager page by using hot keys in the Content Manage interface, press the Ctrl + Alt + Z key combination to access the hot
key mode, and then press P on the keyboard to jump to the Plan Manager page.
The following table provides a list of hot keys for the functionalities on the ribbon of the Plan Manager page. For example, continue pressing V
to jump to the View Details interface.

View Details

Edit

Delete
Test Run
Run Now
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V

E

Functionality Name and Hot Key
Source &Destination
D
Settings
S
Edit
E
Test Run
T
Run Now
R
Close
X
Create Container
N
Save
Save
S
Save As
Save and Run Now
Cancel
D
T
R

S
A
R

C
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Appendix G: Content Manager Customization Support Table
The following is the customization support table of Content Manager. √ means the corresponding SharePoint object is supported to be copied or moved to the corresponding SharePoint objects.
Copy/Move To
What to
Copy/Move
Web application

Web
Application
√

Site
Collection

Site List Folder

Note

What to select when copying/moving

Merge

To Web application:

DocAve 6: Content Manager

93

Copy/Move To
What to
Copy/Move
Site collection

Web
Application
√

Site
Collection
√

Site List Folder
√

Note
To Web application:
Merge/Attach

What to select when copying/moving
To site collection:

To site collection:
Merge/Attach
To site: Merge/Attach

To site:
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Site

√

√

√

To Web application:
Merge
To site collection:
Merge/Attach

To Web application:

To site: Merge/Attach

To site collection:

To site:
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Copy/Move To
What to
Copy/Move

List

Web
Application

Site
Collection

Site List Folder

√

√

Note

To site: Attach

What to select when copying/moving

To site:

To list: Merge
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Copy/Move To
What to
Copy/Move

Web
Application

Site
Collection

Site List Folder

Note

What to select when copying/moving

To list:

Folder

√

√

To list: Attach

To list:

To folder: Merge/Attach
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Copy/Move To
What to
Copy/Move
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Web
Application

Site
Collection

Site List Folder

Note

What to select when copying/moving
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Copy/Move To
What to
Copy/Move

Web
Application

Site
Collection

Site List Folder

Note

What to select when copying/moving
To folder:
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Copy/Move To
What to
Copy/Move
Item
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Web
Application

Site
Collection

Site List Folder
√

Note

What to select when copying/moving

Attach
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Copy/Move To
What to
Copy/Move
Apps

Web
Application

Site
Collection

Site List Folder

√

√

Note

What to select when copying/moving

To site collection:
When copying or
moving to the
destination site
collection, the Apps are
attached to the toplevel site of the
destination site
collection.
To site:
Attach

SharePoint Built-in
Workflow

√

√

√

√

If you want to copy or move the workflow, you must select the SharePoint objects that is associated with the workflow on the tree, and select the Include
workflow definition/Include workflow instance.
If the workflow in the source node is In Progress, by default the status in the destination node will be Canceled after being migrated. If you select the Restart the
workflow radio button, the status in the destination node will still be In Progress after being migrated.
*Note: Content Manager does not support the workflow instances associated with the checked-out files.

SharePoint designer
workflow

√

√

√

√

Nintex workflow

√

√

√

√

Reusable workflow template is supported if the workflow has been applied in the Content Type.
Reusable workflow template without creating any workflow definition is supported.
If the workflow in the source node is In Progress, by default the status in the destination node will be Canceled after being migrated. If you select the Restart the
workflow radio button, the status in the destination node will still be In Progress after being migrated.
*Note: Content Manager does not support the workflow instances associated with the checked-out files.
Reusable workflow template is only supported if the workflow has been applied in the Content Type.
Schedule in Nintex Workflow is only supported when both Include workflow definition and Include workflow instance are selected.

DocAve 6: Content Manager

101

Copy/Move To
What to
Copy/Move

Web
Application

Site
Collection

Site List Folder

Note

What to select when copying/moving

If the workflow in the source node is In Progress, by default the status in the destination node will be Canceled after being migrated. If you select the Restart the
workflow radio button, the status in the destination node will still be In Progress after being migrated.
*Note: Content Manager does not support the workflow instances associated with the checked-out files.
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Appendix H: The Supported and Unsupported Methods
to Copy or Move Sites of Different SharePoint
Experience Versions
Refer to the following table for the information of the SharePoint experience versions that are
supported by Content Manager:


Source Experience Version – The experience version of the source node.



Destination Experience Version– The experience version of the destination node.



Supported Status – Whether or not Content Manager supports to copy or move from
the source SharePoint nodes to the destination SharePoint nodes.

Source Experience Version
SharePoint 2010 on-premises
SharePoint 2013 on-premises with
2010 experience version
SharePoint 2013 on-premises with
2010 experience version

Destination Experience Version
SharePoint 2010 on-premises
SharePoint 2013 on-premises with
2010 experience version
SharePoint 2013 on-premises with
2013 experience version

Supported Status
Supported
Supported

SharePoint 2013 on-premises with
2010 experience version
SharePoint 2013 on-premises with
2013 experience version
SharePoint 2013 on-premises with
2013 experience version
SharePoint 2013 on-premises with
2013 experience version
SharePoint 2013 Online with 2013
experience version
SharePoint 2013 Online with 2013
experience version
SharePoint 2013 Online with 2013
experience version

SharePoint 2013 Online with 2013
experience version
SharePoint 2013 on-premises with
2010 experience version
SharePoint 2013 on-premises with
2013 experience version
SharePoint 2013 Online with 2013
experience version
SharePoint 2013 on-premises with
2010 experience version
SharePoint 2013 on-premises with
2013 experience version
SharePoint 2013 Online with 2013
experience version

Partially Supported
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Partially Supported
Only support
copying/moving data in
the list level or below.

Unsupported
Supported
Supported
Unsupported
Supported
Supported
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Unsupported SharePoint Elements for Partially Supported
Methods
Refer to the following sections about the unsupported SharePoint elements for partially supported
methods and the solutions for these unsupported SharePoint elements.

Master Page
The master pages in the SharePoint 2010 are different from those in the SharePoint 2013. When copying
or moving the master pages from the source to the destination, the destination master pages will use
the destination SharePoint experience version, and the master page gallery and the settings will be
skipped.

Site Template
Some of the site templates in the SharePoint 2010 are not compatible with those in the SharePoint
2013. Refer to the table below for the supported and unsupported site templates when copying or
moving the source node to destination node with a different SharePoint experience version.


ID – The ID of the site template.



Name – The name of the site template.



Title – The title of the site template.



Supported Status – Whether or not the site template is supported by Content Manager.

IDID

Name

0
1
1
1
2
2
2
2
2
3
4
9
15
16
2764
N/A
N/A

GLOBAL#0
STS#0
STS#1
STS#2
MPS#0
MPS#1
MPS#2
MPS#3
MPS#4
CENTRALADMIN#0
WIKI#0
BLOG#0
SGS#0
TENANTADMIN#0
ACCSRV#0
ACCSRV#1
ACCSRV#3

N/A

ACCSRV#4
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Title
Global template
Team Site
Blank Site
Document Workspace
Basic Meeting Workspace
Blank Meeting Workspace
Decision Meeting Workspace
Social Meeting Workspace
Multipage Meeting Workspace
Central Admin Site
Wiki Site
Blog
Group Work Site
Tenant Admin Site
Access Services Site
Assets Web Database
Charitable Contributions Web
Database
Contacts Web Database

Supported Status
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Unsupported
Unsupported
Unsupported
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IDID
N/A
N/A
7
14483
14483
40
3100
3200
20
21
22
30
31
32
39
53
53
53
33
34
36
38
47
50
51
52
54
56
90
90
N/A

Name

Title
ACCSRV#5
Projects Web Database
ACCSRV#6
Issues Web Database
BDR#0
Document Center
OFFILE#0
(obsolete) Records Center
OFFILE#1
Records Center
OSRV#0
Shared Services Administration Site
PPSMASite#0
PerformancePoint
BICenterSite#0
Business Intelligence Center
SPS#0
SharePoint Portal Server Site
SPSPERS#0
SharePoint Portal Server Personal
Space
SPSMSITE#0
Personalization Site
SPSTOC#0
Contents area Template
SPSTOPIC#0
Topic area template
SPSNEWS#0
News Site
CMSPUBLISHING#0
Publishing Site
BLANKINTERNET#0
Publishing Site
BLANKINTERNET#1
Press Releases Site
BLANKINTERNET#2
Publishing Site with Workflow
SPSNHOME#0
News Site
SPSSITES#0
Site Directory
SPSCOMMU#0
Community area template
SPSREPORTCENTER#0
Report Center
SPSPORTAL#0
Collaboration Portal
SRCHCEN#0
Enterprise Search Center
PROFILES#0
Profiles
BLANKINTERNETCONTAINER#0 Publishing Portal
SPSMSITEHOST#0
My Site Host
ENTERWIKI#0
Enterprise Wiki
SRCHCENTERLITE#0
Basic Search Center
SRCHCENTERLITE#1
Basic Search Center
SRCHCENTERFAST#0
FAST Search Center

Supported Status
Unsupported
Unsupported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Unsupported

List Template
All the list templates can be copied or moved to the destination.
*Note: Both the shared documents library and the document library (which is created automatically
after activating the SharePoint Server Publishing Infrastructure feature in the SharePoint 2010 site
collection) will be copied or moved to the destination documents library in SharePoint 2013 mode site.

Theme
When copying or moving the themes from the source to the destination, the destination themes will use
the destination SharePoint experience version, and the theme gallery and the settings will be skipped.
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Web Part
Refer to the table below for the supported and unsupported Web parts when copying or moving the
source node to destination node with a different SharePoint experience version. The unsupported Web
parts will be skipped.


Type – The type of the Web part.



Title – The title of the Web part.

Type

Title

Business Data

Content Rollup

Filters

Forms
Media and Content
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Business Data Actions
Business Data Connectivity Filter
Business Data Item
Business Data Item Builder
Business Data List
Business Data Related List
Chart Web Part
Excel Web Access
Indicator Details
Status List
Visio Web Access
Categories
Content Query
Relevant Documents
RSS Viewer
Site Aggregator
Sites in Category
Summary Links
Table Of Contents
Web Analytics Web Part
WSRP Viewer
XML Viewer
Apply Filters Button
Choice Filter
Current User Filter
Date Filter
Page Filed Filter
Query String (URL) Filter
SharePoint List Filter
SQL Server Analysis Service Filter
Text Filter
HTML Form Web Part
InfoPath Form Web Part
Content Editor
Image Viewer

SharePoint
2010
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y

SharePoint
2013
Y
Y
N
Y
Y
Y
N
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
N
N
N
Y
Y
Y
Y
Y
Y
N
Y
Y
N
Y
Y
Y
Y
Y
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Type

Title

Media Web Part
Page Viewer
Picture Library Slideshow Web Part
Silverlight Web Part
Outlook Web App
My Calendar
My contacts
My Inbox
My Mail Folder
My Tasks
Search
Advanced Search Box
Dual Chinese Search
Federated Results
People Refinement Panel
People Search Box
People Search Core Results
Refinement Panel
Related Queries
Search Action Links
Search Best Bets
Search Box
Search Core Results
Search Paging
Search Statistics
Search Summary
Search Visual Best Bet
Top Federated Results
Social Collaboration Contact Details
Note Board
Organization Browser
Site Users
Tag Cloud
User Tasks
SQL Server
SQL Server Reporting Services Report Viewer
Reporting
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SharePoint
2010
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y

SharePoint
2013
Y
Y
Y
Y
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
Y
N
N
N
N
N
N
Y
Y
N
Y
Y
Y
N
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Notices and Copyright Information
Notice
The materials contained in this publication are owned or provided by AvePoint, Inc. and are the property
of AvePoint or its licensors, and are protected by copyright, trademark and other intellectual property
laws. No trademark or copyright notice in this publication may be removed or altered in any way.
Copyright
Copyright © 2012-2016 AvePoint, Inc. All rights reserved. All materials contained in this publication are
protected by United States and international copyright laws and no part of this publication may be
reproduced, modified, displayed, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording or otherwise, without the prior written consent
of AvePoint, 3 Second Street, Jersey City, NJ 07311, USA or, in the case of materials in this publication
owned by third parties, without such third party’s consent. Notwithstanding the foregoing, to the extent
any AvePoint material in this publication is reproduced or modified in any way (including derivative
works and transformative works), by you or on your behalf, then such reproduced or modified materials
shall be automatically assigned to AvePoint without any further act and you agree on behalf of yourself
and your successors, assigns, heirs, beneficiaries, and executors, to promptly do all things and sign all
documents to confirm the transfer of such reproduced or modified materials to AvePoint.
Trademarks
AvePoint®, DocAve®, the AvePoint logo, and the AvePoint Pyramid logo are registered trademarks of
AvePoint, Inc. with the United States Patent and Trademark Office. These registered trademarks, along
with all other trademarks of AvePoint used in this publication are the exclusive property of AvePoint and
may not be used without prior written consent.
Microsoft, MS-DOS, Internet Explorer, Office, Office 365, SharePoint, Windows PowerShell, SQL Server,
Outlook, Windows Server, Active Directory, and Dynamics CRM 2013 are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.
Adobe Acrobat and Acrobat Reader are trademarks of Adobe Systems, Inc.
All other trademarks contained in this publication are the property of their respective owners and may
not be used without such party’s consent.
Changes
The material in this publication is for information purposes only and is subject to change without notice.
While reasonable efforts have been made in the preparation of this publication to ensure its accuracy,
AvePoint makes no representation or warranty, expressed or implied, as to its completeness, accuracy,
or suitability, and assumes no liability resulting from errors or omissions in this publication or from the
use of the information contained herein. AvePoint reserves the right to make changes in the Graphical
User Interface of the AvePoint software without reservation and without notification to its users.
AvePoint, Inc.
Harborside Financial Center, Plaza 10
3 Second Street, 9th Floor
Jersey City, New Jersey 07311
USA
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